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CHAPTER 1 : LOGGING ON

This chapter explains how to:

• Log on to the Oracle Daybreak system
• Change a password
• Reset a password
• Log off from the Oracle Daybreak system.

Logging on
At the beginning of each Oracle Daybreak session and prior to working with any account, 
you must log on at your workstation. Oracle Daybreak then allows you to “enter” the sys-
tem and open the programs available according to your level of responsibility. To log on to 
Oracle Daybreak, you need to have your own user id and password. Each user id is 
attached to a responsibility level, or “profile,” that controls the user’s access to various 
areas of the system. Your user id is associated to all the accounts you process. 

The ability to log on is automatically disabled after a specified number of days of inactiv-
ity. The user id and password required to log on to Oracle Daybreak may be different from 
the user id and password used to log on to your computer or network. If you are unsure of 
your user id and password for Oracle Daybreak, contact your system administrator.

To log on to the Oracle Daybreak system

1 Follow the guidelines for your business to launch the iAS window and begin a Oracle 
Daybreak session. 

After starting Oracle Daybreak, the Login form appears.

2 In the User Id field, type your user identification name.
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3 Press TAB to move to the Password field.
-or-
Click the Password field.

4 In the Password field, type your password.

5 Choose Connect.
-or-
Press ENTER.

Note: If you choose Cancel, Oracle Daybreak closes the Login form.

If your user id or password is inaccurate, Oracle Daybreak displays the following dialog 
box:

• Choose OK and retype your user id and password. If problems logging on persist, con-
tact your system administrator.

IMPORTANT: 
The length of a password is established during system setup. Special characters (&, @, #, 
$, %, ^, &, *, and so on) cannot be used to create a password. To prevent others from see-
ing your password, your password does not appear in the Password field as you type it. 
Instead, your keystrokes appear as asterisks (*). Keep your password confidential to pre-
vent access to Oracle Daybreak by unauthorized users.

If Oracle Daybreak recognizes your user id and password, the login form updates to dis-
play and automatically complete the User Id, User Name, Responsibility, Organization, 
and Division fields. Your user id appears as the title of the form.
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When you successfully log on to Oracle Daybreak, the menu items available to your 
responsibility are available. (Whatever menu items are “unavailable” are visible, but 
dimmed.)

If you have not logged out of Oracle Daybreak, have an old Oracle Daybreak session 
open, or you did not correctly exit your previous Oracle Daybreak session, when you 
attempt to log in again, the following dialog box appears:

•  Choose Yes to close your existing sessions.

Note: The majority of the time, you will choose Yes. Choose No only if you want to work 
with multiple Oracle Daybreak sessions.
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Changing passwords
Passwords will automatically expire after a period of time set by your system administra-
tor. Oracle Daybreak notifies you of approaching password expiration dates with a mes-
sage dialog box that appears after you log on. 

To change your password

1 Close all open Oracle Daybreak forms and return to the User Id form.

2 On the File menu, choose Change Password.

The Old Password, New Password, and Confirm New Password fields appear on the form, 
along with the Change Password and Cancel buttons.

3 In the Old Password field, type your old password and press TAB.

4 In the New Password field, type your new password and press TAB.

5 In the Confirm New Password field, retype your new password and choose Change 
Password.

Oracle Daybreak displays the following dialog box:

6 Choose Ok.
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Resetting passwords
Oracle Daybreak allows you to reset your password from the Login form by choosing the 
Forgot Password button. This command button can be used when:

• You forget your password
• You discover that your password is not working (as another user might have disabled 

or changed it)
• Oracle Daybreak disables your password after you entered the wrong password multi-

ple times.

To reset your password with the Forgot Password button

1 Close all open Oracle Daybreak forms and return to the User Id form.

2 In the User Id field, enter your user identification.

3 Choose Forgot Password.

Oracle Daybreak generates a random alphanumeric password and sends this new pass-
word to the email address listed in your record on the Administration form’s Users page. 
Oracle Daybreak then displays a Forms dialog box with the message “Password Reset 
Successfully. You should receive the new password in your email shortly.”
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Logging off
When exiting Oracle Daybreak, always use one of the following procedures:

• On the File menu, choose Exit or Re-Logon
-or-
On the Oracle Daybreak menu bar, choose Exit.
-or-
On the Login form, press CTRL+Q.

Oracle Daybreak closes the session and releases any accounts you may have been working 
on.

IMPORTANT: 
Do not choose the Close button on the Oracle Daybreak menu bar to end a Oracle Day-
break session
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CHAPTER 2 : CUSTOMER SERVICE

Account maintenance and collections tasks can be performed with Oracle Daybreak’s 
Customer Service form.

The Customer Service form allows you to view and manage all customer information in a 
centralized location to assure data integrity and provide better service. Oracle Daybreak 
provides online real-time information about the applicant(s), contract, account balances, 
dues, transactions, call activities, and comments. Oracle Daybreak also supports back-dat-
ing of financial transactions up to account’s opening date.

Customer Service form is divided into tabs that perform the following tasks:

• Search for and load accounts on the Customer Service form
• View comprehensive account and customer details, including status, balances, trans-

action histories, payoff quotes, statements, escrow information, insurance informa-
tion, and vendor work orders.

• Track attributes associated with an account
• View vendor work orders
• Record call activities, promises to pay, comments, and references
• Use checklists to perform customer service tasks
• View payment rating history and due date history
• Perform monetary and nonmonetary maintenance on an loan 
• Record information concerning bankruptcies, repossessions, foreclosures, and account 

deficiencies
• View contract information recorded during the funding process
• View information regarding account collateral
• Perform a credit bureau pull
• Add comments to an account during any time of the customer service process.

This chapter explains how to do all of this.
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Activating an account
An account is automatically activated when you fund the contract with the Funding form 
or when you activate an account with the Conversion App/Acc form. You cannot activate 
an account with the Customer Service form.

Posting and reversing payments
A payment can be posted and reversed on the Consumer Lending (Advance and Payment) 
form. You cannot post and reverse the payment in Customer Service form. (For more 
information, see the Batch Transactions chapter.)

A note about account numbers
After an application completes the loan origination cycle and is funded or is ported into 
Oracle Daybreak through the DLS Open Interface, it becomes an account and receives an 
account number.

Oracle Daybreak assigns account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date
NNNNNNN = serial number
X = check digit

Oracle Daybreak sorts accounts using the NNNNNN portion only. That portion is what we 
call the account ID.
Chapter 2 :-2    User Guide - Consumer Loans Collection 



Search (1) master tab
There are a number of different ways to load an account on the Customer Service form.

• Use the Search (1) master tab (similarly to the Underwriting and Funding forms)
• Use the Search block on the Customer Service form’s master page
• Use the Next Account feature to load an account from a predefined queue
• Use the Auto Run feature.

To search for and load an account with the Search (1) master tab

Note: This procedure is explained in detail in the Searching for Accounts chapter.

1 On the Lending menu, choose Customer Service.

The Customer Service form appears, opened at the Account Details page.
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2 Choose the Search (1) master tab, then choose the Search tab.

3 In the Search Criteria block, use the Comparison Operator and Values columns to cre-
ate the search criteria you want to use to find an account.

Note: Choose Reset Criteria at any time to clear the Comparison Operator and Values 
columns.

4 Choose Search. 

Oracle Daybreak locates and displays on the Results page all the accounts that meet your 
search criteria in the Search Criteria block.

Note: The Secured check box indicates whether the account is secured and may only be 
loaded by authorized users.

5 On the Results page, double-click the account you want to retrieve.

Oracle Daybreak loads the account on the Customer Service (2) master tab’s Account 
details page. 

You are now ready to begin work on the account.
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To load an account with the Customer Service form’s master block

1 On the Lending menu, choose Customer Service.

2 In the Search block’s Acc # field, enter the account number of the account you want to 
load and press ENTER.

Oracle Daybreak displays the account details on the Customer Service form’s Account 
Details page. (Note: This method will locate a single account.)
-or-
In the Search block’s SSN field, enter the social security number of the applicant on the 
account and press ENTER. 

Oracle Daybreak displays all the accounts involving the applicant with that social security 
number on the Customer Service form’s master block Accounts block.

Note: If you complete both the Acc # and the SSN fields, Oracle Daybreak displays the 
account with that account number and all the accounts involving the applicant with that 
social security number on the Customer Service form’s master block Accounts block.

To view the loan origination information about an account

1 On the Lending menu, choose Customer Service.

2 Load the account you want to work with.

3 If you choose Underwriting from the Lending menu, Oracle Daybreak opens the Under-
writing form and loads the underwriting information from which the account was created. 

4 If you choose Funding from the Lending menu, Oracle Daybreak opens the Funding form 
and loads the funding information from which the account was created.
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A note about conditions and queues
Accounts do not have sub statuses; instead, accounts use conditions. Conditions further 
define the status of an account; for example, an account may be delinquent, bankruptcy, 
and scheduled for charge off. Conditions can be applied automatically by Oracle Daybreak 
based on set up and manually by Oracle Daybreak users with the Customer Service form.

Oracle Daybreak can assign accounts to specific users by way of queues. Queues are a 
workflow management tool that allow Oracle Daybreak users to work on accounts sequen-
tially from a prioritized list, rather than having to manually search for and load them. 
Queues are created and sorted during nightly processing. Examples of customer service 
queues include due date change requests, delinquent accounts, deferment requests, and 
title and insurance follow-up.

Oracle Daybreak assigns accounts to queues based on the account’s condition. 

However, an account can have more than one condition, so an account can be in more than 
one queue.In the example below, the single account for Hughs Meyers has two different 
conditions, Schedule for Chargeoff and Delinquent. It can appear in two different queues, 
one for Schedule for Chargeoff and one for Delinquent. 
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Multiple queues can be created for a single condition. Account attributes (such as number 
of days delinquent and product code) can be used for assigning accounts to a queue and 
sorting accounts within a queue. 

You can quickly load an account from a queue using the Next Account feature in the Cus-
tomer Service form master block.

To use the Next Account feature

1 On the Lending menu, choose Customer Service.

2 In the Search block of the Customer Service form master block, select the queue you want 
to work with in the Queue field and choose Next Account (Nx).

Oracle Daybreak displays the account details for you on the Customer Service form’s 
Account Details page.

Note: The accounts are selected from the predefined queue based on the following criteria:

• Accounts in the appointment list
• Accounts with the oldest next follow-up date and time
• Accounts meeting the sort criteria defined in the Queue Setup.

If the user has the authority to review queues without entering call activities, then only 
those accounts based on the sort criteria are selected.

To use the Auto Run feature

1 On the Lending menu, choose Customer Service.

2 In the Search block of the Customer Service form master block, select Auto Run.

Oracle Daybreak displays the account details for you on the Customer Service form’s 
Account Details page.
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Customer Service form’s master block
The Customer Service master block contains the Search block and the Accounts block. 
The Search block allows you to search for and load an account. The Accounts block pro-
vides a quick overview of an account by displaying its status, loan type, payoff amount, 
oldest due date, company, and branch. The information on the Customer Service form 
always refers to the account selected in the master block.

To view an account’s details in the master block

1 Open the Customer Service form and load the account you want to work with. 

2 On the Customer Service form’s master block, view the following information in the 
Accounts block:

In this field: View this:

Acc # Account number.
Status Account status.
Product Product.
Payoff Amt Payoff amount.
Amt Due Delinquent amount due.
Oldest Due Dt Due date.
Company Company.
Branch Branch.
Total (Payoff Amt) Total payoff amount.
(Total) (Amt Due) Total amount due.
# of Accounts Total number of accounts that the customer has in Oracle 

Daybreak, regardless of status (this includes closed 
accounts).
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Customer Service (2) master tab
The Customer Service (2) master tab contains information that is useful to all customer 
service personnel. The master tab contains the following pages:

• Account Details
• Customer Details
• Balances
• Transactions 
• Statements
• Escrow (available if this account contains escrow information)
• Insurances
• Vendor Work Orders.

Account Details page
The Account Details page displays information about the current state of the account.It’s a 
quick snapshot of the most important account-related information, including:

• Customer and contact information
• Dues (including delinquencies, late charges, and nonsufficient funds)
• conditions
• Dates of activities and payments, as well as payment amounts
• Number of delinquencies by length of overdue payment
• Number of broken promises
• Number of nonsufficient funds.

To view the Account Details page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose Account Details.
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3 View the following information:

In this field: View this:

Customers block
Customer Name (unlabeled) Customer name.
Relationship (unlabeled) Customer’s relationship to the account.
Customer # Customer number (unique customer identifier).
SSN Customer’s social security number. Note: If the organiza-

tional parameter UIX_HIDE_RESTRICTED_DATA is set 
to Y, this appears as a masked number; for example, 
XXX-XX-1234.

Birth Dt Customer’s date of birth.
Gender Customer’s gender.
Email Customer’s email address.
Language Language spoken by the customer.
Marital St Customer’s martial status.
Disability Customer disability indicator If selected, this indicates 

that the customer is disabled.
Skip Customer’s skip indicator. If selected, this indicates that 

the customer is a skip debtor. This is selected using the 
Maintenance (3) master tab.

Stop Correspondence Stop correspondence indicator. If selected, Oracle Day-
break will not send correspondence to customer. This is 
selected using the Maintenance (3) master tab.

Privacy Opt-Out Privacy opt-out indicator. If selected, indicates that the 
applicant has elected to refrain from the non-public shar-
ing of information (optional).

Time Zone The applicant’s time zone.
Active Military Duty Active military duty indicator. If selected, indicates that 

the customer is on active military duty and may qualify 
for the rates in accordance with the Servicemembers 
Civil Relief Act of 2003 (SCRA).

Contact Information block
Address Type Address type.
Current If selected, indicates that this is the current address. 
Mailing If selected, indicates that this is the mailing address.
Phone Phone number.
Address (unlabeled) Address details.

Dues block
Today’s Payoff Payoff (for today).
Oldest Due Dt Due date.
Delq Due Delinquent amount.
LC Due Late charges due.
NSF Due Nonsufficient funds fee due.
Other Due Other dues.
Total Due Total amount due.
Due Dt (1) Due date.
Amt (1) Amount due.
Due Dt (2) Due date.
Amt (2) Amount due.
Due Dt (3) Due date.
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Amt (3) Amount due.
Due Dt (4) Due date.
Amt (4) Amount due.
Due Dt (5) Due date.
Amt (5) Amount due.

Activity block
Effective Dt Account effective date.
Active Dt Date account was made active.
Paid Off Dt Date account was paid off.
Chargeoff Dt Date account was charged off.
Current Pmt Current payment amount.
Due Day Due day for payment.
Last Pmt Amt Last payment amount.
Pmt Dt Last payment date.
Last Bill Amt Last bill amount.
Last Activity Dt Last activity date.
Producer Channel and producer of the account.
Behavior Score Behavior score.
App# Application number from which this account was cre-

ated.
Customer Grade Displays the customer grade.
Score Displays the score.
Military Duty If selected, indicates that at the time of billing, the cus-

tomer was in active military duty and qualifies for rates 
in accordance with Servicemembers Civil Relief Act 
(SCRA) of 2003.

Conditions block
Condition Condition.
Start Dt Start date.
Followup Dt Next follow-up date.
Alert Alert on the account (This is a message marked “alert” on 

the Comments master page or Comments sub page.)

Delinquency Information block
Late The number of times less than 30 days delinquent over 

the life of the account.
30 The number of times 30 days delinquent over the life of 

the account.
60 The number of times 60 days delinquent over the life of 

the account.
90 The number of times 90 days delinquent over the life of 

the account.
120 The number of times 120 days delinquent over the life of 

the account.
150 The number of times 150 days delinquent over the life of 

the account.
180 The number of times 180 days delinquent over the life of 

the account.
BP (Life) The number of broken promises over the life of the 

account.
NSF (Life) The number of nonsufficient funds over the life of the 

account.
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BP (Year) The number of broken promises this year.
NSF (Year) The number of nonsufficient funds this year.
Days The number of days delinquent. A negative number in 

this fields denotes the number of days until a payment is 
due.

Category The delinquency category.
Collector The default collector working on the account.

Account Details sub pages
The Accounts Details page shares the same sub pages with the Customer Details, Business 
and Vendor Work Order pages, as well as the Bankruptcy (4), Repo/Foreclosure (5), and 
Deficiency (6) master tabs: Call Activities, Promises, Comments, Checklist, Refer-
ences, Payment Rating History, and Due Date History.

Using these sub pages, you can complete the following Customer Service tasks:

• Record call activity
• Make and cancel an appointment
• Cancel a promise to pay
• View payment promises
• Record additional comments
• Complete a checklist
• Record a new reference
• View the customer’s payment rating history
• View the customer’s due date history.
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Using the Call Activities sub page
With the Call Activities sub page, Oracle Daybreak allows you to record the details of all 
actions performed regarding this account. This includes calls from the customer, calls you 
make regarding the account, or changes to the condition of the account. Entries in the Call 
Activities page are listed in reverse chronological order of follow-up date. 

Note: Call activity action codes (Action field) and call activity results codes (Results field) 
are user-defined.

The code for the call action and call result is what appears on the Call Activity sub page.

To record call activity

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Call Activities sub tab.

4 In the Action field, select the action performed.

5 In the Result field, select the result of the action.

6 If you want, complete the following optional fields:

In this field: Do this:

Contact Select who you contacted.
Reason Select the reason for the communication.

7 In the Condition field, select the condition or queue type. Conditions determine the 
queue/condition for the contents of the Action field and set the follow up data for that 
queue/condition.
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The LOV that is used in the Condition field is the intersection of the list of condition set-
ups for what is entered in the Action and Result fields and the open conditions on the 
account.

8 In the Followup Dt field, type the next follow-up date; that is, the next scheduled review. 
(This may automatically default based on setup.)

9 In the Time Zone field, view the default time zone for the customer. You can update this 
information if necessary.

10 In the Adj. Followup Dt field, view the adjusted followup date based on the contents of 
the Followup Dt and Time Zone fields. 

Note: This information appears after you save the entry.

11 Save any changes you made to the account.

Oracle Daybreak automatically creates a comment for your entry on the Comments sub 
page and master tab using the description for the call action and call result, not the code.

Making an appointment
The Appointment box on the Call Action sub page allows you to schedule an account to 
appear in a particular queue at a future date and time. When you make an appointment, the 
account will appear in the front of the queue listed in the Conditions field at the time listed 
in the Followup Dt field.

Note: You must be working that queue at the followup time in order to view the account. 

To make an appointment

1 Complete the fields on the Call Action sub page (see above, To record call activity).

2 In the Condition field, select the condition for the queue you want the account to appear 
in.

3 In the Followup Dt field, type the date and time you want the account to appear. This can 
be either the current day or a day in the future.

4 If necessary, update the Time Zone field if the customer is going to be in a different time 
zone at the time of the appointment.

5 Select the Appointment box.

Note: If account was not worked within the queue on day of the appointment, the nightly 
jobs will cancel the appointment. Also, if the account’s queue condition changes during 
the nightly batch jobs, the outstanding appointments are cancelled.
Chapter 2 :-14    User Guide - Consumer Loans Collection 



Canceling an appointment
Using the Call Activities sub page, you can cancel an appointment for an account. The 
account will still appear in the queue on the follow up date, but no longer receive a prior-
ity.

To cancel an appointment

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Call Activities sub tab.

4 If you need to change the time for the appointment, create a new entry on the account’s 
Call Activities sub page with the same condition, but enter a new followup date.

If you need to cancel the appointment, create a new entry on the account’s Call Activi-
ties sub page with the same condition, but don’t check the Appointment check box.

5 Save any changes you made to the account.

Recording a promise to pay
If you record an action on the Call Activities sub page as a “promise to pay,” it appears on 
the Promises sub page. The Promises sub page allows you to quickly view these actions 
without searching for them individually and displays the 25 most recent promises to pay.

To record a promise to pay

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Call Activities sub tab.

4 In the Action field, select the action performed.

5 In the Result field, select PP PROMISE TO PAY.

6 If you want, complete the following optional fields:

In this field: Do this:

Contact Select the contact type. (Who was the person you com-
municated with?) (optional).

Reason Select the reason, as stated by the contacted person. 
(What is the reason for this contact?) (optional).

Promise Dt Record the date when the person you spoke with prom-
ises to make payment (optional).

Promise Amt Record the amount of the payment the person you spoke 
with promises to make (optional).

7 In the Condition field, select the condition or queue type.

8 In the Followup Dt field, enter the next follow-up date for the promise-to-pay or accept 
the default date.
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9 Save any changes you made to the account.

Oracle Daybreak automatically notes this information as an entry on the Promises and 
Comments sub pages.

Canceling a promise to pay
Oracle Daybreak allows you to cancel promises to pay with the Call Activities sub page. 
You would do this when a customer informs you prior to the promise date that he or she 
cannot make the payment. 

To cancel the existing promise to pay 

1 Open the Customer Service form and load the account (loan) you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Call Activities sub tab.

4 To find the existing promise to pay:

• Press F7 to move to Enter-Query mode.
-or-

• Select Enter Query button on the tool bar.

5 Search for the promise to pay you want to cancel using the Promise Amt field or Promise 
Dt field.

6 Press F8 to perform the query.
-or-
Select Execute Query button on the tool bar.

7 In the Call Activities sub page, select the promise you want to cancel.

8 Select the Cancel box.

9 Save the changes you made to the account.

The promise is marked as canceled and will not be considered when processing promises; 
in other words, it will not be counted as either satisfied or broken.
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Using the Promises sub page
If a call was recorded as a “promise to pay” on the Call Activities sub page, it will appear 
on the Promises sub page. The Promises sub page allows you to quickly view details about 
the call and subsequent actions and displays the 25 most recent promises to pay.

If Oracle Daybreak does not receive the promised amount before the promised time, it 
notes the broken promise on the Delinquency Information block of the Account Details 
page.

To view payment promises for an account 

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Promises sub tab.

4 View the following information:

In this field: View:

Promise Amt The amount promised.
Promise Dt The date the promise was made.
Taken By The user who took the promise.
Taken Dt The date the promise was taken.
Collected Amt The amount collected against the promise.
Broken Indicates if this is a broken promise.
Cancelled Indicates if this is a cancelled promise.
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Using the Comments sub page
Oracle Daybreak allows you to record comments on the Customer Service form using the 
Comments sub page. These comments can also appear on the Comments (10) master tab.

To record an additional comment

1 Open the Customer Service form and load the account (loan) you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Comments sub tab.

4 If you want to tag this comment as important, select the Alert box.

Note: If you select the Alert box, the comment appears on the Customer Service form’s 
Account Details page in the Alert field on the Conditions block.

5 In the Type field, select what type of comment you are adding.

6 In the Sub Type field, select what sub type of comment you are adding.

7 In the Comment field, type your comment.

8 When you are finished, save the changes you made to the account.
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Using the Checklist sub page
Oracle Daybreak allows you to create checklists to ensure that procedures are followed to 
complete various tasks. This information appears on the Checklist sub page.

To complete a checklist for an account

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Checklist sub tab.

4 In the Checklist Type field, select the type of checklist you want to complete.

5 Choose Load Checklist.

Oracle Daybreak loads the type of checklist you choose in the Checklist box and the 
checklist in the Action column.

6 As you follow the actions in the checklist, note your work with the Yes/No/NA option but-
tons. 

Note: You can add comments to each action on the checklist in the Comment column.

7 When you complete the check box, select Complete.

8 Save your entry.
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Using the Reference sub page
The References sub page allows you to attach new references to an account at anytime, as 
well as view the references attached to the account during the loan origination cycle.

To add a new reference to the account

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Reference sub tab.

4 Complete the text fields on the Reference sub page.

In this field: Do this:

Relationship Select the reference type (required).
Name Enter the reference name (required).
Yrs Enter the number of years (required).
Mths Enter the number of months (required).
Address Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country (required).
Phone Enter the reference’s primary phone number (optional).
Ext Enter the reference’s primary phone extension (optional).
Phone Enter the reference’s secondary phone number (optional).
Ext Enter the reference’s secondary phone extension 

(optional).
Comment Enter a comment (optional).

5 Save the changes you made to the account.
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Using the Payment Rating History sub page
The Payment Rating History sub page displays the month and year of payment and the rat-
ing reported to credit bureaus through the Metro 2 file for the past 24 months.

To view a customer’s rating history

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Payment Rating History sub tab.

4 View the following display only information:

In this field: View this:

Pmt Rating The payment rating.
Description The payment rating description.
Acc Status The credit bureau account status.
Description The credit bureau account status description.
Month/Year The month/year of payment rating.
Rating The payment rating.
Chapter 2 :-21    User Guide - Consumer Loans Collection 



Using the Due Date History sub page
The Due Date History sub page provides a delinquency history, by payment, by displaying 
a history of all due dates, along with when the actual payment was made for that due date 
and the subsequent balance. If a payment was delinquent, the Due Date History sub page 
displays the number of days the customer was delinquent against each due date.

To view a customer’s rating history

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Due Date History sub tab.

4 View the following display only information:

In this field: View this:

Due Dt The due date.
Due Amt The due amount.
Pmt Dt The payment date.
Pmt Amt The payment amount.
Balance Amt The balance amount.
Days Past Due The days past due.
Pmt Received If selected, indicates the payment was received.
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Customer Details page
Information gathered on the Application Entry form regarding the customer and the cus-
tomer’s address, employment data, and phone numbers appears on the Customer Details 
page. Using the Customer Service form’s Customer Details page, you can update or add to 
a customer’s address, employment information, or phone listing. 

Note: Information about the customer can be changed using the Maintenance (3) master 
tab.

To view or edit customer information

1 Open the Customer Service form and load the account (loan) you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Customer Details tab.

3 Load the customer whose information you want to edit or enhance. Use the scroll bar on 
the right of the Customer block to view all the customers associated with this account. 

In this field: View this:

Customer # Customer number (display only).
Relation Customer’s relationship to the account (display only).
ECOA Customer’s Equal Credit Opportunity Act code (display 

only).
Name Customer’s name (display only).
SSN Customer’s social security number. Note: If the organiza-

tional parameter UIX_HIDE_RESTRICTED_DATA is set 
to Y, this appears as a masked number; for example, 
XXX-XX-1234(display only).

Birth Dt Customer’s date of birth (display only).
Language Customer’s language (display only).
Marital St Customer’s marital status (display only).
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Enabled Customer’s enabled indicator (display only).
Dependents Customer’s number of dependents (display only).
License # Customer’s driving license number (display only).
State Customer’s driving license state (display only).
Mothers Maiden Name Customer’s mother’s maiden name (display only).
Email Customer’s email address (display only).
Class Customer’s classification type (display only).
Time Zone Customer’s time zone (display only).
Stop Correspondence Customer’s stop correspondence indicator. If selected, 

this indicates that Oracle Daybreak will not send the cus-
tomer any correspondence, such as monthly statements. 
This is selected using the Maintenance (3) master tab 
(display only).

Disability Customer’s disability indicator (display only).
Skip Customer’s skip indicator. If selected, this indicates that 

the customer is a skip debtor.This is selected using the 
Maintenance (3) master tab (display only).

Privacy Opt-Out Privacy opt-out indicator. If selected, indicates that the 
applicant has elected to refrain from the non-public shar-
ing of information (optional).

4 To change or add an address, use the Address block text boxes:

In this field: Do this:

Type Select the address type (required).
Postal Type Select the postal address type (required).
# Enter the building number (optional).
Pre Select the street prefix (directional).
Street Name Enter the street name (optional).
Street Type Select the street type (optional).
Post Select the street postfix (directional).
Apt (#) Enter the apartment number (optional).
Address 1 (unlabeled) View the address as entered on line 1 (display only).
Address 2 (unlabeled) Enter address line 2 (optional).
Zip Extension Select the zip code (required).
City Enter the city (required).
St Select the state code (required).
Extension (unlabeled) Enter the zip + 4 extension (required).
Country Select the country (required).
Ph Enter the phone number (required).
Census Tract Enter census tract/BNA code (optional).
MSA Code Enter the metropolitan statistical area (MSA) code 

(optional).
Comment Enter a comment (optional).

• If this is the customer’s current address, select Current.

• If this is the customer’s mailing address, select Mailing.
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5 If the customer is in the military, view the following display only information in the Mili-
tary Services block:

In this field: View this:

Active Military Duty Active military duty indicator. If selected, indicates that 
the customer is on active military duty and may qualify 
for the rates in accordance with the Servicemembers 
Civil Relief Act of 2003 (SCRA).

Order Ref # The order reference number.
Effective Dt The effective date. This is the date the Active Military 

Duty indicator was selected.
Released Dt The release date. This is the date the customer was 

released from active military duty.

6 To edit a customer’s employment information, use the Employment block text boxes:

In this field: Do this:

Type Select the occupation (required).
Employer Enter the employer’s name (required).
# Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country (required).
Occupation Select the occupation (optional).
Title Enter the title (optional).
Ph Enter the work phone number (required).
Ph Extension Enter the work phone number extension (optional).
Comment Enter a comment (optional).

• If this is a customer’s current place of employment, select Current.

7 To record additional phone numbers, use the Telecom block.

In this field: Do this:

Telecom Type Select the telecommunication type (required).
Phone Enter the phone number (required).
Extn Enter the phone extension (optional).
Start Time Enter the best time to call start time (optional).
Time Period (unlabeled) Select the time period for the best time to call start time, 

AM or PM (optional).
End Time Enter the best time to call end time (optional).
Time Period (unlabeled) Select the time period for the best time to call end time, 

AM or PM (optional).
Time Zone Select the applicant’s time zone (optional).
Current Select if this telecom number is current (required).

8 Save any changes you made to the account.

Note: Sub pages for the Customer Details page are described in the Account Details sub 
pages section of this chapter.
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Business page
If this is a SME loan, information gathered on the Application Entry form regarding the 
business and the business’s address, partners and affiliates data, and phone numbers 
appears on the Business page. Using the Customer Service form’s Business page, you can 
update or add to a business’s address, partners and affiliates information, or phone listing. 

To view or edit business information

1 Open the Customer Service form and load the account (loan) you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Business tab.

3 Load the business whose information you want to edit or enhance. Use the scroll bar on 
the right of the Business block to view all the businesses associated with this account. 

In this field: View this:

Organization Type Organization type.
Type of Business Type of the business.
Name of the Business Name of the business.
Legal Name Legal name of the business.
Tax Id # Tax identification number.
Start Date Business start date.
# of Employees (Curr) Current number of employees at the business.
# of Employees Number of employees at the business after financing.
Contact Person Contact person at the business.
Business Checking Bank Bank name of the business’s checking account.
Bank Account Number Bank account number.
Average Checking Balance Average checking balance.
# of Locations Number of locations of the business.
Management Since Year the current management was established.
Chapter 2 :-26    User Guide - Consumer Loans Collection 



4 To change or add an address, use the Address block text boxes:

In this field: Do this:

Type Select the address type (required).
Postal Type Select the postal address type (required).
# Enter the building number (required).
Pre Select the street prefix (directional) (optional).
Street Name Enter street name (optional).
Street Type Select the street type (optional).
Post Select the street postfix (directional) (optional).
Apt # Enter the apartment number (optional).
Address Enter the address (required).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (required).
City Enter the city (required).
St Select the state (required).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country code (required).
Ph Enter the phone number (required).
Own / Rent Select the ownership type (required).
Comment Enter a comment (optional).

• If this is the business’s current address, select Current.

• If this is the business’s mailing address, select Mailing.

5 To record additional phone numbers for the business, use the Telecom block.

In this field: Do this:

Telecom Type Select the telecommunication type (required).
Phone Enter the phone number (required).
Ext Enter the phone extension (optional).
Current If selected, indicates that this is the current record.
Time Zone Select the applicant’s time zone (optional).
Current Select if this telecom number is current (required).

6 To edit a business’s partners information, use the Partners block text boxes:

In this field: View this:

First Name Enter the partner’s first name (required).
MI Select the partner’s middle name (optional).
Last Name Enter the partner’s last name (required).
Suffix Enter the partner’s suffix (optional).
SSN Enter the partner’s social security number (required).
Birth Dt Enter the partner’s birth date (required).
Birth Place Enter the partner’s birth place (optional).
Networth Enter the partner’s net worth (required).
Gross Income Enter the partner’s gross income. (required).
Language Enter the partner’s language (required).
Nationality Enter the partner’s nationality (optional).
Title Select the partner’s title (optional).
Ownership (%) Enter the percentage of ownership held by the customer 

(required).
Email Enter the partner’s email (optional).
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Phone Enter the partner’s phone (required).
Extn Enter the partner’s phone extension (optional).

7 To edit a business’s affiliate information, use the Affiliates block text boxes:

In this field: Do this:

Organization Type Select the affiliate’s organization type (required)
Legal Name Enter the affiliate’s legal name (required)
Business Name Enter the affiliate’s business name (required)
Tax ID Enter the affiliate’s tax identification (required)
Ownership (%) Enter the affiliate’s percentage of ownership (required)
No of Employees Enter the affiliate’s number of employees (required)
NAICS CODE Enter the affiliate’s North American Industry Classifica-

tion System code (required).

8 Save any changes you made to the account.

Note: Sub pages for the Customer Details page are described in the Account Details sub 
pages section of this chapter.
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Balances page
Details of an account’s balance can be viewed on the Balance page. The Balances page 
contains four action buttons in the Balance Group block: Current Balance, Deficiency Bal-
ance, Non-Performing Balance, and Terminate Balance. 

Depending on which one you select, a different set of balance information appears. In all 
cases, the Balance page can be viewed in two transaction period modes: ITD/CTD (Incep-
tion-to-date: loans)/Cycle-to-date: line of credit) and YTD (year-to-date).

To view account balance information

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances tab.

3  In the Balance Group block, select the balance you want to view.

• Current Balance displays the current balances for accounts with an status of ACTIVE. If 
you choose Current Balance, the following information appears:

In this field: View:

Balance Type The balance type.
Opening Balance The opening balance amount.
Posted The amount posted (in addition to the opening balance).
Paid The amount paid.
Waived The amount waived.
Charged Off The amount charged off.
Adjusted (-) The amount adjusted (negative adjustments).
Adjusted (+) The amount adjusted (positive adjustments).
Balance The current (closing) balance.
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Total Balance The total of the account balance.

• Deficiency Balance displays the current balances for accounts with an status of 
CHARGED OFF. If you choose Deficiency Balance, the following information appears:

In this field: View:

Balance Type The balance type.
Opening Deficiency The opening deficiency balance.
Chargeoff Posted The additional charged off amounts posted.
Recovery The amount of deficiency balance paid.
Deficiency Balance The current (closing) deficiency balance.
Deficiency Balance (total) The total deficiency balance.

• Non-Performing Balance displays the current balance for accounts with an status of 
NON-PERFORMING. Non-Performing accounts fall between CHARGED OFF accounts and 
ACTIVE accounts. These accounts are treated as active when dealing with the customer, 
but for accounting purposes are treated differently as they are expected to charge off in the 
future. Fee and interest balances are not expected to be collected in full and therefore are 
not recognized as income. If you choose Non-Performing Balance, the following infor-
mation appears:

In this field: View:

Balance Type The balance type.
Opening Non-Performing The opening nonperforming balance.
Paid The amount of nonperforming balance paid.
Paid Excess The additional nonperforming amounts posted.
Waived The amount waived.
Adjusted (-) The amount adjusted (Negative adjustments).
Adjusted (+) The amount adjusted (Positive adjustments).
Balance The current (Closing) nonperforming balance.
Total Balance The total deficiency balance.

4 In the Txn Period block, choose how you want to view the balance:

• Choose ITD/CTD to view transactions by Inception-to-date (loans)/Cycle-to-date (line of 
credit)
-or-

• Choose YTD to view the transactions by year to date. 
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Transactions page
The Transaction page displays all transactions with a monetary impact that have occurred 
over the life of the account. Transactions can be sorted by when the transaction was made 
effective (Post Dt) or the date the transaction was created (Txn Dt). You can also choose to 
view all transactions or reverse certain transactions. This information comes from the pay-
ments and advances applied to the account, maintenance tasks, and nightly processes such 
as billing.

To view the transaction history of an account

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Transactions tab.

3 In the View Options block, select the type of transactions in this account’s history you 
want to view in the Transactions block.

If you select this: Oracle Daybreak displays:

Good Payments All valid payments that were neither voided nor reversed.
All Payments All transaction involving payments.
Good Txns All transactions that were neither voided nor reversed.
All Txns All transactions.

4 In the Sort By block, choose Post Dt to sort the entries on in the Transactions block in 
order of when the transaction was made effective. 

-or-
Choose Txn Dt to sort the entries on in the Transactions block in order of when the trans-
action was created.

In either case, Oracle Daybreak displays the following information:

In this field: View:

Transactions block
Post Dt The transaction posting date.
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Txn Dt The transaction effective date.
Txn Description The transaction details.
Txn Amt The transaction amount.
Txn Details The transaction details.
Balance Amt The balance amount. Note: This is the principal balance, 

not the total balance amount.
Details block
Txn The transaction allocation details.
Amt The transaction allocation amount.
Description block
Payment Type The payment type.
Reference The reference number associated with the transaction.
Mode The mode of the transaction.
Reason The reason for the transaction.

To reverse (or void) a transaction 

1 Load the account with the transaction you want to void using the Customer Service form.

2 Choose the Customer Service (2) master tab, then choose the Transactions tab.

3 In the Transactions block list box, select the transaction you want to reverse in the Txn 
Description column. (You may have to use the scroll bar to find the transaction).

4 In the Action block, choose Reverse.

Note: Some transactions cannot be reversed. If a transaction cannot be reversed, the 
Reverse button will be dimmed when the transaction is selected. 

In this example, the Reverse button is available. The transaction ADJUSTMENT TO SER-
VICING EXPENSES - ADD can be reversed.
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In this example, the Reverse button is unavailable. The transaction PAYMENT (Y) cannot 
be reversed.

Access to the Reverse button can be restricted by user responsibility and the account’s 
product type using the PAYMENT_REV transaction code (Super Group: ACCOUNT 
MONETARY TXN) on the Administration form. (For more information, see the Txn Codes 
page section in the Oracle Daybreak Lending Suite Setup Guide).

To void an account

Oracle Daybreak can be configured to void an account using the Reverse button on the 
Transaction page. 

1 Load the account you want to void using the Customer Service form.

2 Choose the Customer Service (2) master tab, then choose the Transactions tab.

3 In the View Option block of the Transactions page, choose Good Txns.

4 In the Transactions block, select the ACTIVE entry in the Txn Description field.

5 In the Action block, choose Reverse.

In the Transactions block, Oracle Daybreak creates an entry of REVERSE ACTIVE and 
reverses all transactions. Oracle Daybreak also changes the status of the account to 
CLOSED: VOID and changes the status of the application to APPROVED-VOID (or what-
ever the account’s last status was before funding).

Note: To use this feature, the ACTIVE _REV transaction code must be enabled and set to 
manual on the Administration form for your user responsibility and account’s product 
type. For more information, see the Txn Codes page section in the Oracle Daybreak 
Lending Suite Setup Guide.
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Tracking Attributes page
The Tracking Attributes page allows you to link information to an account that is not 
tracked by default in the Oracle Daybreak system, but is part of your company’s business 
practices; for example, the location of important documents, how customers receive pay-
checks, or the hint questions for remembering a PIN number. Such attributes are defined 
during system setup.

To track attributes on the Customer Service (2) master tab

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Tracking Attributes tab.

3 Choose Create Tracking.

Oracle Daybreak loads the tracking parameters.

4 If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute 
box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the Parameter display.

5 Complete the Tracking block by entering the requested parameter in the Value field.

6 Save any changes you made to the account.
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Balances, Transactions, Tracking Attributes, and Insurances pages’ 
sub pages

The Balances, Transactions, Tracking Attributes, and Insurances pages share the following 
sub pages: 

• Loan Details (fixed rate and variable rate loans only)
• Rate Schedule (variable rate loans only)
• Addl Loan Details
• Repayment Schedule
• ACH
• Coupon
• LoC Balance Details
• Card Details

Note: Depending on the type of loan and the method of payment, only certain sub pages 
will be available.

Loan Details sub page 
The Loan Details sub page for fixed rate loans contains further information about the loan, 
including interest and accruals, extensions and due dates, and additional details.

To view the Loan Details sub page for fixed rate loans

1 Open the Customer Service form and load the loan account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.

3 Choose the Loan Details sub tab.

4 View the following fixed rate loan information on the Loan Details sub page: 

In this field: View:
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Interest and Accruals block
Rate The current rate.
Last Rate Change Dt The last rate change date.
Accrual Start Dt The accrual start date.
# of Rate Changes (Year) The number of rate changes (year).
Last Accrual Dt The last accrual date.
# of Rate Changes (Life) The number of rate changes (life).
Stop Accrual The stop accrual indicator. If selected, indicates that not 

interest is currently accrued.
Rate Start Of Year The rate at start of the year.
Accrual Mthd The current accrual calculation method.
Rebate Mthd The current rebate calculation method.

Extensions and Due Dates block
# of Extensions (Year) The number of times extensions granted (year).
# of Extensions (Life) The number of times extensions granted (life).
# of Extension Term (Year) The number of terms extensions granted (year).
# of Extension Term (Life) The number of terms extensions granted (life).
# of Due Day Changes (Year) The number of due date changes (year).
# of Due Day Changes (Life) The number of due date changes (life).
Last Extn Dt The last extension date.
Due Day Chg Dt The last due date change date.

Additional Details block
Total Term The total term.
Paid Term The paid term.
Maturity Dt The maturity date.
Balloon Amt The balloon amount.

Rate Schedule sub page
The Rate Schedule sub page contains information about rate adjustments, such as the 
sequence and number of adjustments. The Rate Schedule sub page only applies to variable 
rate loans.

To view the Rate Schedule sub page

1 Open the Customer Service form and load the loan account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.

3 Choose the Rate Schedule sub tab.
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4 View the following loan information on the Rate Schedule sub tab: 

In this field: View:

Rate Schedule block
Seq The sequence number for rate adjustment.
Adjustment Frequency Type The rate adjustment frequency type.
Period The rate adjustment period for the frequency.
# of Adjustments The number of rate adjustments for the frequency.

Addl. Loan Details sub page
The Addl. Loan Details sub page contains further information about the loan, such as the 
advance and securitization details.

To view the Addl. Loan Details sub page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.

3 Choose the Addl. Loan Details sub tab.
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4 View the following loan information on the Addl. Loan Details sub tab:

In this field: View:

Advance Details block
Approved Amt The sanctioned amount.
Consumed The total consumed.
Remaining Amt The advance balance.
Last Advance The last advance balance.
Last Adv. Dt The last advance date.

Securitization Details block
Pool Id The the pool id.
Pool Status The pool account status.
Pool Sale Dt The pool sale date.
Repurchase If selected, indicates that repurchasing is allowed.
Dt The repurchase date.

Repayment Schedule sub page
The Repayment Schedule contains information about the schedule of repayment such as 
the date and payment amount.

To view the Repayment Schedule sub page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.

3 Choose the Repayment Schedule sub tab.
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4 View the following information on the Repayment Schedule sub tab: 

In this field: View:

Repayment Schedule block
Seq The payment sequence number.
Date The repayment date.
# of Pmts The number of payments.
Pmt Amt The payment amount.
Generated If selected, indicates that the repayment schedule has 

been generated.

ACH sub page
If the account uses an automated clearinghouse method of payment, then the ACH sub 
page is available. The ACH sub page displays information about automated clearinghouse 
and electronic fund transfers. This information can be edited using the Maintenance (3) 
master tab and the nonmonetary transaction ACH MAINTENANCE.

To view the ACH sub page

1 Open the Customer Service form and load the account with the ACH you want to work 
with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.
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3 Choose the ACH sub tab.

4 View the following information on the ACH sub page: 

In this field: View:

Bank Information block
ACH If selected, indicates that ACH is enabled.
Bank The bank name.
Start Dt The ACH start date.
Routing # The routing number.
Account Type The account type.
Account # The account number. Note: If the organizational parame-

ter UIX_HIDE_RESTRICTED_DATA is set to Y, this 
appears as a masked number; for example, 
XXXXX1234.

ACH Debit Amt The payment amount.
Debit Freq The payment frequency.
Debit Day The payment day.

Coupon sub page
If the account uses a coupon book method of payment, then the Coupon sub page is avail-
able. The Coupon sub page displays coupon order information and whether another book 
has been ordered. This information can be edited using the Maintenance (3) master tab and 
the nonmonetary transaction COUPON BOOK MAINTENANCE.

To view the Coupon sub page

1 Open the Customer Service form and load the account with the coupon you want to work 
with.
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2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.

3 Choose the Coupon sub tab.

4 View the following coupon information on the Coupon sub page:

In this field: View:

Coupon Book Information block
Order If selected, indicates coupon book is ordered.
Order Dt The coupon book order date.
Ordered By The user id of the user who ordered the coupon book.
# of Coupons The number of coupons.
First Pmt Dt The first payment date.
Coupon Starting # The starting number of the coupon book.
First Coupon Dt The first coupon date.
Coupon Ending # The ending number of the coupon book.
Last Coupon Dt The last coupon date.

LoC Balance Details sub page
The LoC Balance Details sub page displays promotion details and credit insurance. This 
information is created during the creation of the account.

To view the LoC Balance Details sub page

1 Open the Customer Service form and load the account with the promotion details you 
want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.
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3 Choose the LoC Balance Details sub tab.

4 View the following balance details on the LoC Balance Details sub page:

In this field: View:

Promotion Details block
Promotion The balance promotion.
Type The balance promotion type.
Start Dt The balance date.
End Dt The balance promotion end date.
Rate The balance rate.
Term The balance term.

Credit Insurance block
Insurance The balance insurance.
Status The balance insurance status.
Sub Type The balance insurance sub type.

Card Details sub page
The Card Details sub page displays information regarding credit cards associated with the 
account. 

To view the Card Details sub page

1 Open the Customer Service form and load the account with the promotion details you 
want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.
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3 Choose the Card Details sub tab.

4 View the following display only credit card details on the Card Details sub page:

In this field: View:

Credit Card Details block
Card Type The credit card type.
Start Dt The credit card start date.
Card Company The credit card company.
Card # The credit card number.
Expiration Dt The expiration date.
Pmt Amt The card payment amount.
Billing Address The billing address for the credit card.
Zip The zip code for the billing address for the credit card.
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Statements page
The Statements page contains three display only blocks. The Statements block displays a 
list all the statements generated during the life of the account. The Transaction block dis-
plays monetary transactions applied to the account from the closing date of the previous 
statement through the closing date of the current statement. The Messages block displays 
the user-defined message that appears in the statement.

To view the Statements page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Statements tab.

The Statements block displays the following information:

In this field: View:

Closing Dt The statement closing date.
Due Dt The statement due date.
Generation Dt The statement generation date.

3 In the Statements block, select the statement you to view.

Oracle Daybreak displays the following information for the selected statement in the 
Transactions and Messages block.

In this field: View:

Transactions block
Txn Dt The transaction effective date.
Description The transaction.
Amount The transaction amount.

Messages block
Seq # The sequence number.
Message The message.
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The Statements pages has three sub pages: Loan  one of which will appear depending on 
what kind of account you have loaded. 

4 View the statement details on the available sub page.

• If the Loan sub page for fixed rate loans is available, view the following information:

In this field: View:

Statement Details block
Current Balance The current balance.
Current Due The current due.
(+) Past Due The past due amount.
(+) Late Charge The late charge due.
(+) Other Charges The other charges due.
= Total Due The total due.
Payoff Dt The payoff date.
Payoff Amt The payoff amount.

Escrow block
Current Balance The current escrow balance.
Current Due The current escrow due.
Past Due The past due escrow amount.

• If the Loan sub page for variable rate loans is available, view the following information:

In this field: View:

Statement Details block
Current Balance The current balance.
Current Due The current due.
(+) Past Due The past due amount.
(+) Late Charge The late charge due.
(+) Other Charges The other charges due.
= Total Due The total due.
Payoff Dt The payoff date.
Payoff Amt The payoff amount.

Rate block
Last Rate Change Dt The last rate change date.
Current Rate The current rate.

Escrow block
Current Balance The current escrow balance.
Current Due The current escrow due.
Past Due The past due escrow amount.
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Escrow page
The Escrow page is a display only page that allows you to view escrow details such as the 
escrow amount due, current escrow payment, escrow balances, and whether escrow analy-
sis is required. The Escrow page contains two sub pages, the Escrow Details sub page and 
the Escrow Transactions sub page.

Note: The Escrow page is only available if escrow is allowed for the account. 

To view the Escrow page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Escrow tab.

3 In the Escrow Due block, view the following information:

In this field: View:

Escrow Amt Due The escrow amount due on the account belonging to the 
escrow balance type (this is the sum of Amt due 1 to Amt 
due 5).

Due Dt (1) The due date.
Amt (1) The amount due.
Due Dt (2) The due date.
Amt (2) The amount due.
Due Dt (3) The due date.
Amt (3) The amount due.
Due Dt (4) The due date.
Amt (4) The amount due.
Due Dt (5) The due date.
Amt (5) The amount due.
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4 The Escrow block contains the following check boxes related to the escrow:

Check box: If selected, then:

Escrow Allowed Escrow is allowed for this account.
Opt Out Customer has optioned out of escrow.
Analysis Required Analysis of this escrow is required. Escrow analysis can 

be performed with the Escrow Analysis and Disburse-
ments form (for more information, see the Escrow Analy-
sis chapter in this User Guide).

Stop Disbursement Disbursement is stopped. Note: Escrow disbursement can 
be stopped or resumed using a nonmonetary transaction 
on the Maintenance (3) master tab.

Stop Analysis Escrow is stopped. Note: Escrow analysis can be stopped 
or resumed using a nonmonetary transaction on the 
Maintenance (3) master tab.

5 In the Escrow Payment block, view the following information:

In this field: View:

Current Escrow Pmt The current escrow payment amount. This is the standard 
escrow installment due every term.

6 In the Escrow Balance block, choose how you want to view the escrow:

If you choose: Oracle Daybreak displays:

ITD Transactions by inception to date.
YTD Transactions by year to date. 

7 In the Escrow Balance block, view the following information:

In this field: View:

Opening Balance The opening balance.
Received The received balance.
Interest Received The interest received balance.
Disbursed The disbursement balance.
Adjusted (-) The amount adjusted (negative).
Adjusted (+) The amount adjusted (positive).
Balance The current balance.
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Escrow Details sub page
The Escrow page contains two sub pages: Escrow Details and Escrow Transactions. The 
Escrow Details sub page displays additional information regarding the escrow, while the 
Escrow Transaction sub page displays monetary and nonmonetary escrow transactions, 
such as payments made towards the escrow balance and disbursements made from the 
escrow balance.

To view the Escrow Details sub page

1 Open the Customer Service form and load the escrow account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Escrow tab.

3 Choose the Escrow Details sub tab.

4 In the Escrow Type and Sub Type fields, view the escrow type and sub type. (Use the 
scroll bar to select different escrow types.)

5 The Escrow Details sub page indicators display the following information:

Indicator: If selected, then:

Required Escrow Escrow is required.
Cushion Allowed Cushion is allowed.
Opt Out Customer has optioned out of the escrow.
Current Escrow is current.

6 In the Disbursement block, view the following information:

In this field: View:

Rule The rule.
Vendor The vendor name.
Account # The account number. Note: If the organizational parame-

ter UIX_HIDE_RESTRICTED_DATA is set to Y, this 
appears as a masked number; for example, 
XXXXX1234.

Maturity Dt The maturity date.
Yearly Amt The yearly amount.
Next Disb Dt The next disbursement date.
Last Disb Dt The last disbursement date.

7 In the Insurance block, view the following information:

In this field: View:

Coverage Type The coverage type.
Policy # The policy number.
Coverage Amt The coverage amount.
Coverage Term The coverage term.
Effective Dt The effective date.
Expiration Dt The expiration date.

8 In the Tax block, view the following information:

In this field: View:

Property Tax The property tax.
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To view the Escrow Transactions sub page

1 Open the Customer Service form and load the escrow account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Escrow tab.

3 Choose the Escrow Transactions sub tab.

4 In the Sort By block, select how you want to view the information:

If you choose: Oracle Daybreak:

Post Dt Sorts the entries in order of when the escrow transaction 
was created. 

Txn Dt Sorts the entries in order of when the escrow transaction 
occurred.

5 In the View Options block, select how you want to view the information:

If you choose: Oracle Daybreak displays:

Payments Transactions involving payments.
Disbursements Transactions involving disbursements.
All Txns All transactions.

6 In the Escrow Transactions sub page list box, view the following information:

In this field: View:

Post Dt The post date.
Txn Dt The transaction description.
Txn Description The transaction description.
Txn Amt The transaction amount.
Txn Details The transaction details.

Oracle Daybreak creates a requisition when it posts an escrow disbursement. You can 
view escrow disbursements on the AP Transactions form when you choose Vendor in the 
Payee Type block. For more information, see the Accounts Payable (Requisitions) 
chapter in this User Guide.
Chapter 2 :-49    User Guide - Consumer Loans Collection 



Insurances page
If during the loan origination, the Insurance sub page was completed on the Funding form, 
you can view the financed insurance information on the Customer Service form’s Insur-
ances page. The Insurances page displays detail information related to all financed insur-
ances, including cancellation and refund information whenever applicable. It also displays 
the insurances that were financed after funding of the loan using the Maintenance (3) mas-
ter tab.

To view the Insurances page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Insurances tab.

3 In the Insurance block, view the following display only information:

In this field: View:

Policy Information:
Contractual If selected, indicates that the insurance policy is required 

by contract.
Insurance Type The insurance type.
Sub Type The insurance sub type.
Status The insurance status.
Insurance Plan The insurance plan.
Insurance Mode The insurance mode.
Itemization The contract itemization.
Company The insurance company.
Policy Number The insurance policy number.
Phone No The insurance company’s primary phone number.
Ext The insurance company’s primary phone extension.
Policy Number The insurance policy number.
Phone No The insurance company’s alternate phone number.
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Ext The insurance company’s alternate phone extension.
Effective Dt The insurance effective date.
Expiration Dt The insurance expiry date.
Premium Amt The insurance premium amount.
Term The insurance term.
Commission Rule The insurance premium amount.
Commission Amt The insurance commission amount.
Primary (Beneficiary) The primary beneficiary of the insurance.
Secondary (Beneficiary) The secondary beneficiary of the insurance.
Comments The comments regarding the insurance policy.

Cancellation/Refund block:
Policy Cancellation Dt The insurance cancellation date.
Term Remaining The remaining term on the insurance at cancellation.
Refund Allowed If selected, a refund is allowed. A selected box indicates 

that the insurance premium can be rebated to the cus-
tomer in case of early payoff.

Refund Method The refund calculation method.
Estimated Refund Amt The estimated insurance refund.
Received Refund Amt The insurance refund received.
Complete Refund If selected, a complete refund is allowed.
Grace Day’s Cancellation If selected, indicates that cancellation fees during grace
Fee Allowed period is allowed.
Grace Days   View the number of grace days allowed for cancellation 

without charging a cancellation fee.
Cancellation Fee View the amount of the cancellation fee to be charged 

when the insurance is cancelled.

4 In the Insurance Tracking block, choose Create Tracking.

Oracle Daybreak loads the insurance tracking parameters in the Insurance Tracking block.

5 If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

6 Complete the Insurance Tracking block.

7 Save your entry.
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Vendor Work Order page
To expedite repossessions and foreclosures, the display only Vendor Work Order page 
allows you to view all the work orders issued to different vendors for an account.

To view the Statements page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Vendor Work Order tab.

3 In the Vendor Work Order block, view the following display only information:

In this field: View this:

Work Order #                     The work order number.
Dt                                    The assignment date.
Estimated The estimated dollar amount of work order.
Type                                      The assigned type.
Vendor                                  The vendor number and name.
Status                                    The assigned status.
Total Amt The total estimated dollar amount of all work orders.

4 Select the work order in the Vendor Work Order block you want to view and choose View 
Work Order.

Note: The View Work Order button appears dimmed if your responsibility does not allow 
access to the Vendor form.

Oracle Daybreak opens the Vendor Management form’s Work Orders page with informa-
tion about that work order. You can then perform tasks and record additional information, 
such as changing the work order’s status and adding comments on the Work Orders page.
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Maintenance (3) master tab
The Maintenance (3) master tab acts as a single command stations that allows you to post 
a wide array of monetary and nonmonetary transactions for any given account. The trans-
actions available depend on the nature of the account, whether it is a loan. This section 
explains how to complete the following tasks:

Monetary tasks
Loan:
• Apply, adjust, or waive servicing expenses
• Adjust or waive late charges
• Adjust or waive nonsufficient funds
• Apply, adjust, or waive repossession expenses
• Apply, adjust, or waive bankruptcy expenses
• Apply or adjust phone pay fees
• Change an index/margin rate
• Apply, adjust, or cancel financed insurance
• Generate a payoff quote
• Payoff an account
• Charge-off an account
• Close an account
• Adjust, charge-off, or waive the advance/principal balance
• Adjust the interest balance
• Stop interest accrual
• Indicate a borrower as on or off active military duty
• Change a due date
• Apply, adjust, or waive an extension fee
• Change payment amount
• Adjust or waive a prepayment penalty
• Reschedule an escrow payment
• Adjust or waive an escrow payment
• Adjust or waive a payoff quote fee
• Place an account in a nonperforming condition
• Reverse a nonperforming condition
• Reschedule precompute loan to interest bearing loan

Nonmonetary tasks
Loan:
• Update a customer’s name
• Maintain customer details
• Mark a customer as a skipped debtor
• Change a customer’s Privacy Opt-Out indicator
• Stop correspondence
• Modify financed insurance information
• Start or stop an ACH
• Reprint a statement (batch only)
• Create or cancel a one time ACH - phone pay
• Re-order coupon books
• Cancel or adjust an ESC 
• Apply a refund payment to an ESC 
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• Cancel insurance (or reverse the insurance cancellation)
• Add new escrow insurance details
• Add new escrow tax details
• Change insurance annual disbursement
• Change insurance disbursement plan
• Change escrow indicators of insurance
• Change insurance expiration date
• Change insurance maturity date
• Change tax annual disbursement
• Change tax disbursement plan
• Change escrow indicators of tax
• Resume escrow analysis
• Resume escrow disbursements
• Stop escrow analysis
• Stop escrow disbursements
• Refund or adjust insurance

Oracle Daybreak allows you to post a monetary transaction immediately or submit it for 
nightly processing. The transaction is identified as either a “real-time” or nightly batch 
transaction in Oracle Daybreak’s transaction setup codes. Oracle Daybreak also allows 
you to cancel the future dated transactions or the transaction that have been submitted for 
nightly processing. All the activity on the account, including who performed it and a date 
and time stamp, is captured in the audit trail.

A note about verifying transactions:

You can set up transactions so that they must be validated by a different Oracle Daybreak 
user. With this authorization process, you can view these transactions on the Transaction 
Authorization form before they are posted. When you post such transaction on the Mainte-
nance (3) master tab, they receive a status of WAITING FOR AUTHORIZATION.

Using the Maintenance page for monetary and nonmonetary transac-
tions

All of the monetary and nonmonetary tasks listed in Appendix C: Transaction Parame-
ters use the Maintenance page. Each task requires a Transaction value and a Parameter 
value. 

For each task, complete the following steps:

To use the Maintenance page to complete monetary transactions

1 Open the Customer Service form and load the account you want to work with.
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2 Choose the Maintenance (3) master tab.

3 In the Action block:

• Select the Monetary box to complete a monetary transaction
-or-

• Clear the Monetary box to complete a nonmonetary transaction.

4 In the Transaction field, select the transaction for the task you want to complete. Transac-
tion availability depends on the type of account (loan), whether the transaction is mone-
tary or nonmonetary, and user responsibility.

5 During set up, you can choose to process a transaction in real time or as a batch transac-
tion.

• If a transaction will be performed in a batch transaction, the Batch box appears selected.

• If a transaction will be performed in real time, the Batch box appears cleared. 

6 Choose Load Parameters.

7 Enter all the required parameter values and choose Post.

Oracle Daybreak displays the results (success, failure, or waiting for authorization) in the 
Results block “Transaction Processing Details” list.
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Transactions page (A reminder)
As discussed earlier in this chapter, the Transactions page displays transactions with a 
monetary impact that have occurred over the life of the account. The Transaction page also 
allows you to view transactions or reverse certain transactions you manually perform on 
the Maintenance page. For more information, see the Transaction page section of this 
chapter.
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Bankruptcy (4) master tab
The Bankruptcy page allows you to record the details of a bankruptcy. This information 
usually is supplied from the customer or customer’s attorney. You can track each stage of 
the bankruptcy process based on its follow-up date and record information using the 
Details and Tracking blocks. 

As there are occasions when a borrower files bankruptcy more than once during the tenure 
of the loan, you can record information for multiple bankruptcies. The Create New Bank-
ruptcy button enables you to create a new bankruptcy record with different start and end 
dates. You can also use the Bankruptcy page to view the previous bankruptcy record using 
the scroll bar in the Details block. The Current box in the Details block indicates the cur-
rent bankruptcy details.

To enter bankruptcy details for an account

1 Using the Customer Service form, load the account you want to add bankruptcy details 
to and choose the Bankruptcy (4) master tab.

2 If there is a previous bankruptcy record in the Details block, choose Create New Bank-
ruptcy to refresh the Bankruptcy page.

3 Complete the Details block.

In this field: Do this:

Current box Select to indicate this is the current bankruptcy record.
Followup Dt Enter the follow-up date for the bankruptcy (required).
File Received Dt Enter the file received date for the bankruptcy (optional).
Disposition Select the bankruptcy disposition (required).
Bankruptcy Start Dt Enter the bankruptcy start date (optional).
Type Select the bankruptcy type (optional).
Bankruptcy End Dt Enter the bankruptcy end date (optional).
Comment Enter a comment (optional).
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4 Choose Create Tracking.

Oracle Daybreak loads the bankruptcy tracking parameters.

5 If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

6 Complete the Tracking block.

7 Save your entry.

Note: Sub pages for the Bankruptcy page are described in the Account Details sub 
pages section of this chapter.
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Repo/Foreclosure (5) master tab
The Repo/Foreclosure (5) master tab allows you to record information regarding reposses-
sions on the Repossession page or foreclosures on the Foreclosure page in a manner simi-
lar to how bankruptcies are recorded on the Bankruptcy page. You can track each stage of 
the repossession or foreclosure process based on the follow-up date and record informa-
tion using the Details and Tracking blocks. 

On occasion, a lender performs multiple foreclosures or repossessions for the same loan. 
The Create New Fore Closure buttons on the Repossession and Foreclosure pages enable 
you to create a new repossession or foreclosure record for a different collateral and differ-
ent start and end dates. You can also use the Repossession and Foreclosure pages to view 
the previous repossession or foreclosure information using the scroll bar in the Details 
block. The Current box in the Details block indicates the current repossession or foreclo-
sure record for each asset. 

You can update the current record, but previous records cannot be modified.

To enter repossession details for an account

1 Using the Customer Service form, load the account you want to add repossession details to 
and choose the Repo/Foreclosure (5) master tab, then choose Repossession.

Note: If there is a previous repossession record in the Details block, choose Create New 
Repossession to refresh the Repossession page.

2 Complete the Details block.

In this field: Do this:

Current box Select to indicate this is the current repossession/foreclo-
sure record.

Followup Dt Enter the follow-up date for the repossession/foreclosure 
(required).
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File Received Dt Enter the file received date for the repossession/foreclo-
sure (optional).

Disposition Select the repossession/foreclosure disposition 
(required).

Repo/Forc Start Dt Enter the repossession/foreclosure start date (optional).
Type Select the repossession/foreclosure type (optional).
Repo/Forc End Dt Enter the repossession/foreclosure end date (optional).
Collateral Select the repossession/foreclosure asset (required).
Comment Enter a comment (optional).

3 Choose Create Tracking.

Oracle Daybreak loads the repossession tracking parameters.

4 If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

5 Complete the Tracking block.

6 Save any changes you made to the account.

Note: Sub pages for the Repossession page are described in the Account Details sub 
pages section of this chapter.

To enter foreclosure details for an account

1 Using the Customer Service form, load the account you want to add foreclosure details to 
and choose the Repo/Foreclosure (5) master tab, then choose Foreclosure.

Note: If there is a previous foreclosure record in the Details block, choose Create New 
Foreclosure to refresh the Foreclosure page.
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2 Complete the Details block.

In this field: Do this:

Current box Select to indicate this is the current repossession/foreclo-
sure record.

Followup Dt Enter the follow-up date for the repossession/foreclosure 
(required).

File Received Dt Enter the file received date for the repossession/foreclo-
sure (optional).

Disposition Select the repossession/foreclosure disposition 
(required).

Repo/Forc Start Dt Enter the repossession/foreclosure start date (optional).
Type Select the repossession/foreclosure type (optional).
Repo/Forc End Dt Enter the repossession/foreclosure end date (optional).
Collateral Select the repossession/foreclosure asset (required).
Comment Enter a comment (optional).

3 Choose Create Tracking.

Oracle Daybreak loads the foreclosure tracking parameters.

4 If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

5 Complete the Tracking block.

6 Save any changes you made to the account.

Note: Sub pages for the Foreclosure page are described in the Account Details sub 
pages section of this chapter.
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Recording repossession or foreclosure analysis
The Analysis page allows you to create and analyze possible scenarios for the remarketing 
and the sale of the asset. This enables you to calculate the possible gain or loss in the sale 
of an asset. Expenses already incurred on the asset are displayed on the form. You can 
change the numbers if you expect more expenses by the time the asset is sold. 

Note: You can have three Repo/Foreclosure analyses and three Sales analyses on a work-
sheet, but you can create more than one analysis worksheet. 

To complete a repossession/foreclosure analysis or sales analysis for an 
account

1 Load the account you want to work with on using the Customer Service form.

2 Choose the Repo/Foreclosure (5) master tab, then choose the Analysis tab.

3 Select the Current box if you wish to indicate that this is the current analysis worksheet

4 In the Analysis block, use the Level field to select the analysis level you want to use, 
ACCOUNT or ASSET.

• Choose Account if you want the analysis to use the value of the entire account.

• Choose Asset if you want the analysis to use the value of a particular asset.

5 Enter the following information in the Analysis block:

In this block: Do this:

Balance % Enter balance allocation percentage (required).
Analysis Dt View the analysis date (display only).
Asset If you want to perform an analysis for a particular asset, 

select the asset (optional).
Current Value View the asset current total value (display only).
Analysis Comment Enter comment associated with the analysis (optional).

6 Enter all the required information in the Repo/Foreclosure or Sales block, depending on 
the type of incident you are analyzing.
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7 Complete the details in the Expenses and Refunds sub pages, corresponding to the anal-
ysis or bid number on the Analysis page. 

• To complete the Expenses sub page:

In this field: Do this:

Expense Type Select the expense type (required).
Manual Indicates that the expense was entered manually 

(required).

Repo/Foreclosure block
Analysis1 Amt Enter the expense amount for analysis1 (required).
Analysis2 Amt Enter the expense amount for analysis2 (required).
Analysis3 Amt Enter the expense amount for analysis3 (required).

Sales block
Bid1 Amt Enter the expense amount for bid1 (required).
Bid2 Amt Enter the expense amount for bid2 (required).
Bid3 Amt Enter the expense amount for bid3 (required).

• To complete the Refunds sub page:

In this field: Do this:

Refund Type Select the refund type (required).
Manual Indicates that the refund was entered manually 

(required).

Repo/Foreclosure block
Analysis1 Amt Enter the refund amount for analysis1 (required).
Analysis2 Amt Enter the refund amount for analysis2 (required).
Analysis3 Amt Enter the refund amount for analysis3 (required).

Sales block
Bid1 Amt Enter the refund amount for bid1 (required).
Bid2 Amt Enter the refund amount for bid2 (required).
Bid3 Amt Enter the refund amount for bid3 (required).

The data here is loaded to the analysis and bid columns as “expenses” and “refunds.”
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8 If you are analyzing a repossession/foreclosure, choose the corresponding Load button on 
the Repo/Foreclosure block to load details on the Repo/Foreclosure block spread sheet.

If you are analyzing a sale of an asset, choose the corresponding Load (#) button on the 
Sales block to load details on the Repo/Foreclosure block spread sheet.

If this is a sales analysis and you know who is bidding, complete the Bid By fields.

9 Repeat steps 4 to 8 with information regarding other repossession/foreclosure or sales 
analysis.

10 In the Status field, select the status of the analysis: APPROVED or REJECTED. 

11 When you have decided which analysis or which sale bid you want to approve, select your 
choice in the either the Final Analysis or Final Sales block.

Note: You can approve only one analysis.

12 Save your entry.
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Deficiency (6) master tab
The Deficiency (6) master tab allows you to record information about deficiency accounts 
- accounts that are no longer collectable. You can create and track specific details on the 
status of the charged-off account for timely follow-up and analysis. You can track each 
stage of the deficiency process based on its follow-up date and record information using 
the Details and Tracking blocks.

The Create New Deficiency button enables you to create a new deficiency record with dif-
ferent start and end dates. You can also use the Deficiency page to view the previous defi-
ciency information using the scroll bar in the Details block. The Current box in the Details 
block indicates the current bankruptcy details.

Note: To view the balance of a charged off account, choose the Customer Service (2) 
master tab, then choose the Balances tab and in the Balance Group block, select Defi-
ciency Balance.

To enter deficiency details for an account

1 Using the Customer Service form, load the account you want to add deficiency details to 
and choose the Deficiency (6) master tab.

2 If there is a previous deficiency record in the Details block, choose Create New Defi-
ciency to refresh the Deficiency page.

3 Complete the Details block.

In this field: Do this:

Current box Select to indicate this is the current deficiency record.
Followup Dt Enter the follow-up date for the deficiency (required).
File Received Dt Enter the file received date for the deficiency (optional).
Disposition Select the deficiency disposition (required).
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Charge Off Dt Enter the deficiency start date (optional).
Type Select the deficiency type (optional).
Deficiency End Dt Enter the deficiency end date (optional).
Comment Enter a comment (optional).

4 Choose Create Tracking.

Oracle Daybreak loads the repossession/foreclosure tracking parameters that track actions 
taken to collect on the account.

5 If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

6 Complete the Tracking block.

7 Save your entry.

Note: Sub pages for the Deficiency page are described in the Account Details sub pages 
section of this chapter.
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Contract (7) master tab
The Customer Service form Contract (7) master tab allows you to view the contract and 
truth-in-lending information recorded during the funding process. It’s a display only ver-
sion of the same pages and sub pages found on the Funding form Contract (5) master tab. 

To view an account’s contract information 

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Contract (7) master tab.

Depending on what type of account you selected, the Loan page appears. If you selected a 
loan account with escrow, Escrow Analysis tab is available.

3 Use the following sub pages to view more information about the contract, if available:

• Contract
• Contract (2)
• Itemization
• Trade-In
• Insurance
• ESC
• Escrow
• Compensation (loan)
• Subvention
• Proceeds
• Disbursement to Others (Disbursement...)
• Fee
• ACH
• Coupon
• Real Estate Fields (Real Estate Fie...)

(For a detailed explanation of the contents of the fields on this tab’s pages and sub pages, 
please refer to the Funding or DLS Open Interface chapter.)
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Collateral (8) master tab
The Collateral (8) master tab contains pages that record information regarding any assets 
associated with an account. Collateral can be a vehicle, home, or something else, such as 
household goods. The Collateral tab is not available if the account is an unsecured loan, as 
such loans by definition do not include collateral.

To view the Collateral details 

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Collateral (8) master tab.

•  If the account’s collateral is a vehicle, the Vehicle page appears:

• If the account’s collateral is a home, the Home page appears:
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• If the account’s collateral is neither a vehicle nor a home, the Other page appears:

Substituting collateral
With the Customer Service form, you can substitute one asset for another to be used as an 
account’s collateral. However, you cannot substitute collateral involving homes.

To substitute the collateral for an account

1 Open the Customer Service form and load the account with the collateral you want to sub-
stitute.

2 Choose the Collateral (8) master tab.

Depending on the account you selected, the Vehicle or Other page appears.

3 Press F6 to clear the page.

4 Enter the data regarding the new asset to be used as collateral on the available page 

• If you are using the Vehicle page, complete the Vehicle block:

In this field: Do this:

Asset Class Select the asset class (required).
Asset Type Select the asset type (required).
Sub Type Select the asset sub-type (required).
Identification Number Enter the identification number (optional).
Registration # Enter the registration number (required).
Status Select the asset status (required).
Year Enter the year of the vehicle (required).
Make Select the make of the vehicle (optional).
Model Select the model of the vehicle (optional).
Body Enter the body of the vehicle (optional).
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Desc View the vehicle description (display only).
Condition Select the vehicle condition (optional).
Address (#) Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country code (required).
County Select the county (optional).

Oracle Daybreak validates the VIN if you add or modify the Identification Number field 
on the Customer Service form’s Vehicle page. 

Interface with VINTEK (If interface is installed)
Using the Vintek interface, Oracle Daybreak retrieves the year, make, model, and body of 
the vehicle on the Vehicle page of the Underwriting, Funding, Customer Service, and Con-
version App/Acc forms’ Collateral master tab when you choose Vehicle Details. This time 
saving feature reduces data entry errors. Using the VIN entered in the Identification Num-
ber field, Oracle Daybreak populates the following fields in the Vehicle block:

• Year
• Make
• Model
• Body 

If the Vintek interface is unable to retrieve information based on the VIN entered in the 
Identification Number field, Oracle Daybreak displays an error message.

• If you are using the Other page, complete the Other block:

In this field: Do this:

Asset Class Select the asset class (required).
Asset Type Select the asset type (required).
Sub Type Select the asset sub-type (required).
Identification Number Enter the identification number (optional).
Registration # Enter the registration number (required).
Status Select the asset status (required).
Year Enter the year of the collateral (required).
Make Select the make of the collateral (optional).
Model Select the model of the collateral (optional).
Body Enter the body of the collateral (optional).
Desc View the collateral description (display only).
Condition Select the collateral condition (required).
Address (#) Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
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Country Select the country code (required).
County Select the county (optional).

5 Note: Accounts that are secured with collateral can have exactly one Primary collateral. 
Clear the Primary box on the collateral you are replacing and select the Primary box on 
the new collateral page.

6 Select Substitute on the new collateral page.

7 Save your entry.

Valuation sub page
With the Valuation sub page, you can change the collateral or asset valuation for an 
account. In this process, you reassess the current value of the collateral (which has been 
used to secure the loan) using multiple sources. This helps companies determine if the risk 
of delinquency or charge off is worth the asset securing it.

To add the collateral or asset valuation for an account

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Collateral (8) master tab.

3 On the available page (Vehicle, Home, or Other), choose the Valuation sub tab.

4 If the Valuation sub page already contains information, press F6 to clear it.

5 On the Valuation sub page do the following

In this field: Do this:

Value block
Current Select if this is the current valuation (required).
Valuation Dt Enter the valuation date (required).
Source Select the valuation source (required).
Supplement Enter the valuation supplement (optional).
Edition Enter the valuation edition (optional).
Wholesale (Base) Enter the wholesale value (required).
Usage Enter the usage. This pertains to loans and usually is 

entered as the current mileage on the vehicle (required).
Retail (Base) Enter the retail value (required).
Addons + View the add-ons value (display only).
Usage Value + Enter the usage value; that is, the monetary effect that the 

current mileage has on the value of the vehicle (required).
Total Value = View the total value (display only).

Addons block
Addon/Attribute Select the add-on/attribute (required).
Value Enter the value of the attribute (optional).
Amt Enter the add-on amount (required).

6 Save the changes you made to the account. 

Note: Assets can have exactly one current valuation. NADA and Kelly Blue Book inter-
faces are available only in the client/server environment.
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Tracking sub page
With the Tracking sub page, you can add the collateral or asset tracking details for an 
account. This allows you to track additional data related to an asset, such as the location of 
the title, liens, and insurance information.

To add the collateral or asset tracking for an account

1 Load the account you want to work on using the Customer Service form.

2 Choose the Collateral (8) master tab.

3 On the available page (Vehicle, Home, or Other), choose the Tracking sub tab.

4 Choose Load Details.

5 Enter or select the tracking details in the Tracking Items block.

In this field: Do this:

Tracking Items block
Tracking Item View the tracking type (display only).
Disposition Select the disposition (required).
Start Dt Enter the tracking start date (required).
End Dt Enter the tracking end date (optional).
Followup Dt Enter the next follow-up date (required).
Enabled Select to track the information from the start date in the 

Start Dt field. (required).
Comment Enter a comment (optional).

Tracking Items Details block
Parameter View parameter (display only).
Value Enter the tracking parameter value (optional).

6 Save any changes you made to the account.
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Bureau (9) master tab
The Customer Service form Bureau (9) master tab allows you to create and pull a credit 
bureau report and view the results as a text only file. 

To request a manual credit bureau report

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Bureau (9) master tab.

3 In the New Request block, use the LOV to complete the following fields:

In this field: Do this:

Applicant Select the applicant. 
Spouse Select the applicant’s spouse (if applicable).
Bureau Select the credit bureau (required).
Report Select the credit bureau report type (required).

4 Choose Create Request. 

Oracle Daybreak displays this information in the Bureau Details block and further infor-
mation about the customer in Applicant/Customer Detail block.

5 If you want to receive a copy of a previously pulled credit bureau report, enter the credit 
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details 
block. This allows you to receive a previously pulled credit report from (currently other 
bureaus do no provide a copy) (optional).

6 In the New Request block, choose Submit Request. 

7 Press F8 to refresh the status of the credit request until the credit pull is completed.

Oracle Daybreak displays the latest status of the currently requested bureau report in the 
Bureau Details block.

When the report pull process is complete, the Status field in the Applicant/Customer 
Detail block changes to COMPLETED. The results of the credit bureau pull appear in the 
list box at the bottom of the Customer Service form.

Note: To send a copy of the report to a predefined printer, choose Print Report.
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Comment (10) master tab
The Customer Service form Comment (10) master tab allows you to view and add free-
form text notes regarding an account at any time. This tab contains the same information 
as the Comments sub page.

The Type field allows you to classify comments in user-defined categories. Oracle Day-
break assigns each comment a time-date stamp and records the User Id of who made the 
comment.

To use the Customer Service form Comment tab

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Comments (10) master tab.

3 In the Type block, select the type of comment you are adding.

4 In the Sub Type block, select the sub type of comment you are adding.

5 In the Comments block, type your comment.

6 If you want Oracle Daybreak to recognize this comment as an alert, select Alert.

Note: If you select the Alert box, the comment appears on the Customer Service form’s 
Account Details page in the Comment sub page.

7 Save any changes you made to the account.

Note: Comments on the Comments (10) master tab also appear on the Comments sub 
page.
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CHAPTER 3 : REVIEW REQUESTS

The Review Requests page is primarily a workflow tool used to flag an account for the 
attention of another Oracle Daybreak user and ask for feedback. It allows Oracle Day-
break users to send and receive messages (including e-mail) that make comments regard-
ing a specific account. 

In this chapter, you will learn how to:

• Review a request
• Send a review request
• Respond to a review request
• E-mail a review request
• Close a review request.

Note: While the Review Request page is available on the Underwriting, Funding, and 
Customer Service forms, the screen shots in this chapter will all use the Underwriting 
form. The Underwriting form and Funding form use the same Review Request page and 
contain an Application # column.
 
The Customer Service form’s Review Request page is nearly identical, though the 
Account # column replaces the Application # column.

Review Requests page blocks
The Review Requests pages contains the following blocks:

• Query
• Action
• Email
• Review Request

The Query block contains these option buttons:

If you choose this: Oracle Daybreak:

Originator Displays the active messages with your user id in the 
Originator column of the Review Request block. These 
are the review requests you created.

Receiver Displays the active messages with your user id in the 
Receiver column of the Review Request block. These are 
the messages you received.

Both Displays in the Review Requests block all the active 
messages you created and received with a status other 
than CLOSED.

View All Displays in the Review Requests block all the messages 
you sent and received, both the active and closed.
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The Action block contains these command buttons:

If you choose this: Oracle Daybreak:

Send Request Sends a review request to another Oracle Daybreak user.
Send Response Sends a response to a review request from another Oracle 

Daybreak user.
Close Changes the status of the message to “Closed” and 

removes it from the Review Request block. Note: You 
can view messages with a CLOSED status by selecting 
View All in the Query block.

The Email block contains these command buttons:

If you choose: Oracle Daybreak:

Originator Sends an email of the review request information to the 
person listed in the Originator column on the Review 
Request block.

Receiver Sends an email of the review request to the person listed 
in the Receiver column on the Review Request block.

Note: The email recipient cannot respond or reply to e-mails with the email system.
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Reviewing a request
When you receive a review request, Oracle Daybreak notifies you by completing the 
Pending Request parenthesis in the form’s title bar with the number of unseen messages.

If you are working loan origination and you have a review request, the Pending Request 
parenthesis in the Underwriting or Funding form will contain a number.

If you are working with an account, the Pending Request parenthesis in the Customer Ser-
vice form will contain a number.

To review requests

1 On the Lending menu, choose Underwriting or Funding if you are working in loan origi-
nation or Customer Service is your are working with accounts.

2 If the Pending Request parenthesis in the title bar contains a number, choose the Search 
(1) master tab, then choose the Review Requests tab.

3 In the Query block, choose Receiver.

In the Review Request block, Oracle Daybreak displays all open messages you have 
received. The Review Requests block contains these fields:

In this field: Do this:

Originator View the user id of the request originator (display only).
Priority View the request priority: HIGH, NORMAL, or LOW (dis-

play only).
Receiver Select the request receiver (required).
Account # (Customer Service form only) Select the account number 

which needs review (required).
Reason Select the review reason (required).
Status View the request status (display only).
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Date View the request creation date (display only).
Originator Comment Enter the originator comment (optional).
Receiver Comment Enter the receiver comment (optional).

Note: If you double-click an entry in the Review Request block, Oracle Daybreak does the 
following:

On this form: Oracle Daybreak:

Customer Service Loads the account and displays the Account Details page.
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Sending a message
The Send Request button allows you to send a message to another Oracle Daybreak user. 
However, you must save your message before this button is available.

To send a review request

1 Using the Underwriting, Funding, or Customer Service form, load the account to which 
the message applies.

2 Choose the Search (1) master tab, then choose the Review Request tab.

3 In the Query block, choose Originator. (If necessary, press F6 to create a new record.)

The account number for the loaded account appears in the Account # field.

4 In the Priority field, select High, Normal, or Low from the LOV.

Note: This Priority field helps guide the recipient in responding to requests. It does not 
affect the order in which messages are sent or received.

5 In the Receiver field, use the LOV to select the person you want to receive the message.

6 The Account # field displays the number of the account in the form’s master block. If no  
account is currently loaded, you can use the LOV to complete the field. You can also use 
this field to reference an account other than the one currently loaded on the form.

7 In the Reason field, use the LOV to select the purpose for the review request.

8 In the Originator Comment field, type any additional message you want to send.

9 Choose Save.

10 In the Action block, choose Send Request.

In the Review Request block, the Status field changes to WAITING FOR RESPONSE and 
Oracle Daybreak sends the message.
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Responding to a message
When you receive a message, Oracle Daybreak will notify you by completing the Pending 
Request parenthesis in the form’s title bar with the number of unseen messages. In the fol-
lowing example, two messages are waiting on the Review Request page. 

To respond to a review request

1 On the Lending menu, choose Underwriting or Funding if you are working in loan origi-
nation or Customer Service is your are working with accounts.

2 Choose the Search (1) master tab, then choose the Review Requests tab.

3 In the Query block, select Receiver.

Oracle Daybreak displays the unread messages in the Review Request block.

4 In the Review Request block, double-click the request you want to view.

Oracle Daybreak loads that request’s account on the current form.

5 Perform the request from message on the account.

6 Type your response in the Receiver Comment field.

7 In the Action block, choose Send Response.

Oracle Daybreak sends your response to the originator’s workstation, where it appears on 
the Review Request page with the status RETURN TO ORIGINATOR
The recipient can view the sent response by choosing Receiver and View All in the Query 
block. (The message has a status of RETURN TO ORIGINATOR.)

Back on the originator’s Review Request page, the message appears when Originator is 
selected in the Query block. The message has a status of RETURN TO ORIGINATOR.

Note: Choose Close in the Action block to remove the message from the Review Request 
block.
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E-mailing a review request
While Oracle Daybreak updates the Pending Request number on the title bar to alert you 
of new messages, you can also e-mail a review request to either the originator or a 
receiver. Oracle Daybreak will use the e-mail address recorded in the User Definition 
block on the Administration form’s User page. 

Note: E-mail addresses must be recorded for both the originator and receiver for this fea-
ture to work.

To e-mail a review request

1 On the Lending menu, choose Underwriting or Funding if you are working in loan origi-
nation or Customer Service is your are working with accounts.

2 Choose the Search (1) master tab, then choose the Review Requests tab.

3 Select the message you want to e-mail in the Review Request block.

4 In the Email block, choose Originator to send the message to the person listed in the Orig-
inator field. 
-or-
Choose Receiver to send it to the person listed in the Receiver field.

Oracle Daybreak displays one of the following dialog boxes:

5 Choose Ok.
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Closing a message
You can close a message you created at anytime, regardless of status. However, you can 
only close messages that have your user id in the Originator field. When you close a mes-
sage, Oracle Daybreak removes if from the Review Request block.

To close a message

1 In the Review Request block, select the message you want to close.

2 In the Action block, choose Close.

Oracle Daybreak assigns the message the status of CLOSED and removes it from your 
Review Request block. 

Note: You can review closed accounts anytime by selecting View All in the Query block.
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CHAPTER 4 : IMAGE MAINTENANCE / DOCUMENT TRACKING

The Documents menu opens the Account Document Tracking form. Both allow for the 
paperless storage of documents within Oracle Daybreak, the later with accounts during 
customer service.

Account Document Tracking form
The Account Document Tracking form contains two pages: the Document Tracking page 
and the Document Maintenance page. The Document Maintenance page allows you to 
attach documents to an account in the form of GIF files, PDF files, DOC files, XLS files, 
and TXT files. The Document Tracking page allows you to view these documents. Any 
documents that were attached to the account when it was still an application, (such as the 
application received as a fax and saved as a GIF file), also appear on the Document Track-
ing page.

This chapter explains how use the Image Maintenance form to:

• View an image
• Search for an image
• Split an image of more than one page
• Change the status of an image
• Combine two images into a multiple page image
• Print an image
• Attach documents to applications and then view these documents in a browser.

It also explains how to use the Account Document Tracking form to attach documents to 
accounts and then view these documents in a browser.
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Document Tracking page (Account Document Tracking form)
You can view the documents attached to a particular account by loading the account on the 
Customer Service form, then opening the Account Document Tracking form. You can also 
open the Account Document Tracking form and select from a list of all accounts with doc-
uments attached on the Document Tracking page.

To locate an account document (method one)

1 On the Documents menu, choose Account > Tracking.

The Account Document Tracking form’s Document Tracking page appears.

2 Press F7 to move to Enter-Query mode, in the Acc # field type the account number you 
want to view, and then press F8 to perform the query.
-or-
Select View All and use the scroll box to choose the account with the documents you want 
to view.

Information about the documents attached to the account appears in the Account Docu-
ment and Account Document Details blocks.

To locate an account document (method two)

1 Open the Customer Service form and load the account with the attached document you 
want to view.

2 On the Documents menu, choose Account > Document Tracking.

The Account Document Tracking form appears with the account loaded in Account block 
and information about the document in the Account Document and Account Document 
Details blocks.
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To view a document attached to an account

1 Using one of the two methods above, load the account with the document you want to 
view.

2 In the Account block, view the following information:

In this field: View this:

Acc# Account number.
Account Status Account status.
Title Account title.

3 In the Account Document block, view the following information:

In this field: Do this:

Document Type View the document type (display only).
Comment Enter comment (optional).

4 In the Account Document Details block, view the following information:

In this field: Do this:

Document Sub Type View the document sub type (display only).
Version View the version (version numbers will be incremental 

by batch job, first version will start with 1.0) (display 
only).

Page # View the page number (display only).
Document File Type View the document file type (display only).
Comment Enter comment (optional).

5 Use the Account Document and Account Document Details block to select the docu-
ment you want to view. 

• In multiple paged documents, choose 1 in the Page # field on the Account Document 
Details block to view the all the pages in the document
-or-

• Choose a specific page number to view only that page.

6 Choose View Document.

Oracle Daybreak opens a browser to display the actual document (which browser appears 
depends on what type of document you selected and what browsers are set up to work in 
conjunction with your Oracle Daybreak system).

7 If you want, add comments to the Comments field in the Account Document and 
Account Document Details blocks.

8 Save your entry.
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Document Maintenance page (Account Document Tracking form)
Oracle Daybreak supports the online attachment of document images to an account with 
the Account Document Tracking form’s Document Maintenance page. You can attach the 
documents from either a client machine or server. A default image directory can be main-
tained in Oracle Daybreak using the system parameter: UIX_DEFAULT_IMAGE_PATH. 

When you choose List File in the New Document block on the Document Maintenance 
page, Oracle Daybreak displays all available files in the selected directory in the Docu-
ment Details block. You can use the Document Maintenance and Action blocks to attach 
selected documents to a particular account.

To attach a document to an account from a server

1 On the Documents menu, choose Account > Maintenance.

The Account Document Tracking form’s Document Maintenance page appears.

2 In the Action block, choose Attach Document (Server).

3 In the Select Document block, use the default image directory in the Directory Path 
field. (The default path is the value for the system parameter 
UIX_DEFAULT_IMAGE_PATH).
-or-
In the Directory Path field, enter the full path name to the document on the server that you 
want to attach to an account.

Note: You can choose Reset Path at any time to return to the default image directory.

4 In the Select Document block, choose List File. 

Oracle Daybreak displays the files from the entry in the Select Document block’s Direc-
tory Path in the Document Details block.

5 In the Document Details block, enter the following information:

In this field: Do this:

File Name View the file name (display only).
Document Type Enter the document type (required).
Document Sub Type Enter the document sub type (required).
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Comments Enter any comment you want to associate with the docu-
ment attached to the account (optional).

Acc# Enter the account number of the account to which you 
want to attach the document (optional).

Note: If a document is attached to an account, and the account is loaded on the Customer 
Service form, when you open the Account Document Tracking form’s Document Mainte-
nance page, the account number appears in the Document Maintenance block’s Acc# field. 
You can view the document in a browser by choosing View Document in the Action 
block.

6 Select the Attach indicator to attach the file to the account.

7 Save your entry.

8 In the Action block, choose Post.

Oracle Daybreak attaches the document to the account. The document can be viewed 
using the Account Document Tracking form’s Document Tracking page.

To attach a document to an account from a client machine

1 On the Documents menu, choose Account > Maintenance.

2 In the Action block, choose Attach Document (Client).

3 In the Select Document block, choose Upload From Client. 

An Open dialog box appears.

4 In the Open dialog box, use the Look in: list box to locate the document you want to 
attach to the account.

Note: You can select multiple files by holding the CTRL or SHIFT key on your keyboard.

5 When you have located the document you want to attach to the account in the Open dialog 
box’s File name: field, choose Open.

6 Oracle Daybreak uploads the selected file to the Document Maintenance page and dis-
plays the progress in the Upload Status block.

In this field: View this:

Total File(s) The total files uploaded from client.
Last File The last uploaded file name.
Bytes Uploaded The file upload status in bytes.
File Upload Status (%) The file upload status in percentage.
Overall Upload Status (%) The overall upload status in percentage.

7 In the Document Details block, enter the following information:

In this field: Do this:

File Name View the file name (display only).
Document Type Enter the document type (required).
Document Sub Type Enter the document sub type (required).
Comments Enter any comment you want to associate with the docu-

ment attached to the account (optional).
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Acc# Enter the account number of the account to which you 
want to attach the document (optional).

8 Select the Attach indicator to attach the file to the account.

9 Save your entry.

10 In the Action block, choose Post.

Oracle Daybreak attaches the document to the account. The document can be viewed 
using the Account Document Tracking form’s Document Tracking page.

You can also view the document in a browser by choosing View Document in the Action 
block.

Copy Document
The Action block’s Copy Document command copies the document image from one 
account to another account. This command has no impact on the source account or the 
source account’s document image.

To copy a document to an account from another account

1 On the Documents menu, choose Account > Maintenance.

2 In the Action block, choose Copy Document.

3 In the Document Maintenance block, use the Acc# field to locate the account with the 
image you want to copy.

4 In the Document Maintenance block, choose Search. 

Oracle Daybreak displays the files attached to that account in the Document Details block.

5 In the Document Details block, select the document you want to copy.

6 In the Copy/Move Acc # field, enter the account number of the account to which you want 
to copy the document.

7 Save your entry.

8 In the Action block, choose Post. 

Move Document
The Action block’s Move Document command moves an existing document image from 
one account to another account. This command detaches the document image from the 
source account and attach to second account. 

To move a document to an account from another account

1 On the Documents menu, choose Account > Maintenance.

2 In the Action block, choose Copy Document.

3 In the Document Maintenance block, use the Acc# field to locate the account with the 
image you want to move.
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4 In the Document Maintenance block, choose Search. 

Oracle Daybreak displays the files attached to that account in the Document Details block.

5 In the Document Details block, select the document you want to move.

6 In the Copy/Move Acc # field, enter the account number of the account to which you want 
to move the document.

7 Save your entry.

8 In the Action block, choose Post.
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CHAPTER 5 : CORRESPONDENCE

Oracle Daybreak features two types of correspondence: predefined correspondence tem-
plates for loans included in the baseline system and ad-hoc correspondence that you create 
yourself. The predefined correspondence address matters regarding customer service and 
collections for accounts. They also enable financial organizations to manage bulk mail-
ings.

Collection: COLLECTION LETTER 1
COLLECTION LETTER 2
COLLECTION LETTER 3
CUSTOM LETTER 1
CUSTOM LETTER 2

Ad-hoc correspondence allows you to include information from accounts in documents 
templates you create yourself without manually transferring the data. Ad-hoc documents 
can be generated as either Microsoft Word or PDF files.

Note: Predefined correspondence templates are stored on the Product Setup form’s Letters 
tab’s pages (Setup > Products > Loan > Letters > Loan Letters ).
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Request page
Ad-hoc correspondence can be viewed on the Request page when you have opened an  
account. The page allows you to generate a new letter or view a previously generated let-
ter.

To generate an ad hoc correspondence

1 On the Lending menu, choose Customer Service and load the account for which you 
want to generate the ad hoc correspondence.

2 On the Letters menu, choose Ad-hoc.

3 In the Correspondence Request block, the following information appears regarding the 
account currently loaded:        

In this field: View this:

Level The correspondence type.
Number/Title The entity number and title.
Company The entity company.
Branch The entity branch.

4 In the Correspondence block, use the Correspondence field’s LOV to select the type of 
correspondence you want to generate.

Oracle Daybreak displays the following information in the Correspondence block for the 
selected type of correspondence:

In this field: View this:

Id View the correspondence id (display only).
Correspondence Select the correspondence you want to generated 

(required).
Date View the correspondence generation date (display only).
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5 Press F10 to save your entry.

The Documents block displays all the types of documents available for the type of corre-
spondence you selected. 

6 In the Documents block, view the following information for each document:

In this field: View this:

Document Id The document Id.
Document The document description.
Recipient The recipient description.
E-Form Source The e-form source.
Source Type The source type.
Generated If selected then Oracle Daybreak generated the docu-

ment.

7 In the Documents block, select the correspondence you want to view.

The Elements block displays the elements Oracle Daybreak used to generate the corre-
spondence. 

• If you choose All, Oracle Daybreak displays all elements in the correspondence.

• If you choose User Defined, Oracle Daybreak displays user-defined elements in the corre-
spondence.

8 In the Elements block, view the following information:

In this field: Do this:

Element View the element description.
Content Enter/view the value of the element.

9 Choose User Defined and complete the Content fields for the Element fields you want to 
include in the correspondence.

10 Choose Generate.

Oracle Daybreak “locks” the information included in the correspondence and prevents it 
from being changed.

11 Choose View.

Oracle Daybreak displays a PDF of the ad hoc correspondence.
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Samples of Oracle Daybreak LS predefined correspondence

Collections: Collection letter 1
The predefined Collection letter 1 is automatically sent a configurable number of days 
after an account becomes delinquent (receives a condition of ACTIVE: DELQ on the Cus-
tomer Service form).

The Collection letter 1 is available for loans fixed and variable rate).

To generate the Collection letter 1

1 On the Customer Service form, load the account you want to receive the Collection 1 let-
ter.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Collections sub menu, choose Collections 1.

Example of the Collections letter 1 (loan)
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Collections: Collection letter 2
The predefined Collection letter 2 is automatically sent after a configurable number of 
days for a delinquent account (one with a condition of ACTIVE: DELQ on the Customer 
Service form).

The Collection letter 2 is available for loans (fixed and variable rate).

To generate the Collection letter 2

1 On the Customer Service form, load the account you want to receive the Collection 2 let-
ter.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Collections sub menu choose Collection 2.

Example of the Collection letter 2 (loan)
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Collections: Collection letter 3
The predefined Collection letter 3 is automatically sent after a configurable number of 
days for a delinquent account (one with a condition of ACTIVE: DELQ on the Customer 
Service form).

The Collection letter 3 is available for loans (fixed and variable rate).

To generate the Collections letter 3

1 On the Customer Service form, load the account you want to receive this letter.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Collections sub menu, choose Collection 3.

Example of the Collections letter 3
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CHAPTER 6 : USER PRODUCTIVITY

The User Productivity form is a supervisor feature that allows you to monitor the daily 
performances of Oracle Daybreak users completing loan servicing tasks. These tasks are 
categorized as customer service/collection tasks (loan servicing). 

Note: Oracle Daybreak updates this display only form every day.

Using the User Productivity form, you can review the following daily tallies: 

• Number of accounts worked and call activities, by user
• Number of accounts worked and call activities, by queue.

This chapter explains how to use the User Productivity form to view this information.
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Viewing the Customer Service/Collection tasks
Daily tallies from the Customer Service module appear on the following pages:

• Collector Activity
• Queues Status

Collector Activity page
The Collector Activity page displays the number of accounts worked and call activities by 
collector for the day. It also displays details regarding calls and total number of calls per 
queue.

To view the Collector Activity page

1 On the Monitor menu, choose Users > Productivity > Customer Service/Collection.

2 Choose the Collector Activity tab.

3 In the User block, view the following information:

In this field: View this:

User User code.
Name User name.
Accounts Number of accounts worked.
Call Activities Number of call activities.

4 In the Activity Details block, view the following information for the selected user:

In this field: View this:

Queue Name Queue name.
Left Messages Left message activity count.
Promise To Pay Promise to pay activity count.
No Answer No answer activity count.
Other Other activity count.
Total Total activity count.
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Queues Status page
The Queues Status page displays daily information regarding queues, such as the number 
of accounts worked, number of call activities, number of accounts pending, and totals 
number of accounts in the queue. It also displays information about the users who worked 
these queues and details of the call activities.

To view the Queues Status page

1 On the Monitor menu, choose Users > Productivity > Customer Service/Collection.

2 Choose the Queues Status tab.

3 In the Queues block, view the following information:

In this field: View this:

Company Company.
Branch Branch.
Queue Name Queue name.
Accounts Number of accounts worked.
Activities Number of call activities.
Pending Number of accounts pending.
Total Number of total accounts.

4 In the Activity Details block, view the following information for the selected queue:

In this field: View this:

User User code.
Name User name.
Left Messages Left message activity count.
Promise To Pay Promise to pay activity count.
No Answer No answer activity count.
Other Other activity count.
Total Total activity count.
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APPENDIX A : ORACLE DAYBREAK INTERFACE

This appendix explains the Oracle Daybreak’s graphical user interface (GUI). It defines 
the components commonly found on a GUI, provides an overview of their functions, and 
explains how to:

• Use Oracle Daybreak’s windows and forms
• Work with the parent-child relationships between blocks
• Navigate within the Oracle Daybreak system.

Oracle Daybreak’s graphical user interface
All the forms in Oracle Daybreak appear as graphical user interfaces (GUIs). To use Ora-
cle Daybreak, you need to understand the components found on a GUI, as well as their 
functions. 

Windows and forms
Oracle Daybreak uses two basic GUIs in completing tasks: windows and forms.

Oracle Daybreak Lending Suite uses two windows, the iAS window and the Oracle Day-
break window. The Oracle Daybreak window is the java applet that is running Oracle 
Daybreak. The iAS window is the browser that launched the applet. In this sense, the iAS 
window is the parent of the Oracle Daybreak window. 
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Windows can be maximized, minimized, opened, closed, and repositioned. More than one 
window can be opened on your desktop; windows can overlap or appear adjacent to each 
other. The window that you are currently using, or is currently selected, is the “active” 
window. It appears on the top of the overlapping windows. Windows that are open but not 
selected are “inactive.” The title bar of an active window is a different color than the other 
inactive windows.

For more information on window components, see the Window components section of 
this chapter.

Oracle Daybreak uses forms to complete tasks. A form is an organized display of a mod-
ule’s fields, contained within a window. Forms allow you to enter, view, and update infor-
mation in the Oracle Daybreak system. Each module has its own form. Forms are opened 
from the Oracle Daybreak menu. For example, on the Lending menu, the Underwriting 
command opens the Underwriting form, the Funding command opens the Funding form, 
and the Customer Service command opens the Customer Service form. You can open mul-
tiple forms simultaneously. The forms that are available to you are based on your assigned 
responsibility.

Windows and forms have a very similar appearance, as forms always appear within win-
dows. An easy way to distinguish a window from a form is that a window contains the 
Minimize, Maximize, and Close buttons in the upper right corner, while a form does not. 

For more information on form components, see the Form components section of this 
chapter.
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Window components
This section presents an overview of the components found on windows, as well as their 
use.

Window title bar A horizontal bar containing the name of the window. The active 
window has a different colored title bar to distinguish it from 
other inactive windows.

The title bar also contains the Minimize, Maximize, and Close 
buttons.

The Minimize button reduces the Oracle Daybreak LS applica-
tion to a taskbar button on your desktop’s status bar.

The Maximize button allows you to resize Oracle Daybreak’s 
window on your desktop. (Note: You may have to choose the 
Maximize button to ensure Oracle Daybreak’s window is not cov-
ered by your desktop’s status bar.)

The Close button will quit Oracle Daybreak without logging off. 
(Note: Do not use the Close button to end a Oracle Daybreak ses-
sion.)

Menu bar The horizontal bar containing the menu names. The menu bar is 
located beneath the title bar and contains commands that allow 
you to open, view, and maintain a form. 

Note: You view the contents of a menu by clicking it or pressing 
ALT + [THE UNDERLINED LETTER IN THE MENU NAME]. 
For example, ALT + R opens the Reports menu. Commands can 
be selected using the mouse or by pressing the key of the under-
lined letter in the command name.

The following menus are available from the Oracle Daybreak menu bar. 

File Contains the following commands: 
Save - Records the current data on a form in the 
database.
Re-Logon - Closes the current Oracle Daybreak 
session and refreshes the Login form, allowing 
you to re-log on to Oracle Daybreak without 
leaving the system.
Change Responsibility - Allows you to change 
your Oracle Daybreak responsibility. Responsi-
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bilities determine what Oracle Daybreak features 
are available.
Change Password - Allows you to change your 
Oracle Daybreak password.
Clear Form - Clears the active form of its 
unsaved data.
Print - Prints the contents of an active form.
Exit - Closes the Login form and ends your cur-
rent Oracle Daybreak session.

Edit Contains the following commands:
Cut - Removes selected text from a form and 
stores it in the clipboard buffer.
Copy - Copies selected text from a form and 
stores it in the clipboard buffer.
Paste - Moves data from the clipboard buffer to 
a selected field on a form.
Edit Field - Opens the Editor dialog box with the 
contents of a selected field. 
List of Values - Opens a field’s List of Values 
dialog box, if one exists.

Query Contains the following commands:
Enter - Changes Oracle Daybreak to Enter-
Query mode. This allows you to search the data-
base.
Execute - Performs the query entered during 
Enter-Query mode.
Cancel - Changes Oracle Daybreak back to user 
mode.
Last Criteria - Repeats the most recently per-
formed query entered in Enter-Query mode.
Count Hits - Displays the number of records the 
current query produced in the message line.
Get Next Set - Retrieves the next set of records 
using the most recent query entered while in 
Enter-Query mode.

Navigation Contains the following commands:
Block - Allows you to navigate to the previous 
or next block, or clear the current block.
Record - Allows you to navigate between the 
previous and next record, scroll up and down 
between records, insert or remove a record, or 
duplicate or clear a record.
Field - Allows you to navigate between the pre-
vious and next field, as well as clear or duplicate 
a field.

Lending Contains the following commands:
Customer Service - Opens the Customer Ser-
vice form.
Collection - Opens the Customer Service form 
designed for a Oracle Daybreak user focussing 
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on collections, as the Bankruptcy (4), Repo/Fore-
closure (5), and Deficiency (6) master tabs are 
unavailable.
Repossession/Foreclosure - Opens the Cus-
tomer Service form designed for a Oracle Day-
break user focussing on repossessions or 
foreclosures, as the Bankruptcy (4), and Defi-
ciency (6) master tabs are unavailable.
Bankruptcy - Opens the Customer Service form 
designed for a Oracle Daybreak user focussing 
on bankruptcies, as the Repo/Foreclosure (5) and 
Deficiency (6) master tabs are unavailable.
Deficiency - Opens the Customer Service form 
designed for a Oracle Daybreak user focussing 
on deficiencies, as the Bankruptcy (4) and Repo/
Foreclosure (5) master tabs are unavailable.
Collateral - Opens the Collateral form (currently 
unavailable).
Producers - Opens the Producer Management 
form.
Vendors - Allows you to open the Vendor Man-
agement form at the Vendors, Work Orders, or 
Invoices tab.
Securitization - Opens the Securitization form at 
the Loan tab.

Transaction Authorization - Opens the Trans-
action Authorization form at the Authorization 
tab.
Custom Forms - [This is a placeholder for any 
forms customized (or added) by the client.]

Letters Contains the following commands:
Pre-defined - Allows you to generate a pre-
defined letter, either as a file or a printed docu-
ment, or preview it as a PDF file.
Ad-hoc - Opens the Correspondence form.

Documents Contains the following commands:
Account - Allows you to open the Account Doc-
ument Tracking form at either the Document 
Tracking or Document Maintenance master tab.

Reports Contains the following commands:
Run - Allows you to generate a wide array or 
predefined reports. 
Print - Modifies the Run command to generate a 
predefined report, either as a file or a printed 
document.
Preview - Modifies the Run command to gener-
ate a predefined report and view it as a PDF file 
with a browser.

Interfaces Contains the following commands:
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GL Transactions - Opens the General Ledger 
form.
AP Transactions - Opens the AP Transactions 
form.
Card Transactions - Opens the Card Transac-
tions form.
Conversions - Opens the Conversion App/Acc 
form.

Batch Contains the following commands:
Transactions Advances - Allows you to open the Consumer 

Lending (Advance and Payment) form at either 
the Advance Entry or Advance Maintenance tab.
Payments - Allows you to open the Consumer 
Lending (Advance and Payment) form at either 
the Payment Entry or Payment Maintenance tab.
Escrow - Allows you to open the Escrow Analy-
sis and Disbursements form at the Escrow Anal-
ysis, Escrow Analysis Maintenance, Escrow 
Disbursement Entry, or Escrow Disbursement 
Maintenance master tabs.

Monitor Contains the following commands:
System - Allows you to open the Utilities form 
at the Setup, Monitor Batch Jobs, Monitor Jobs, 
Monitor Users, Services, Log Files, or Parked 
Transactions master tab.
User - Allows you to open the Utilities form at 
the Monitor Users master tab or open the User 
Productivity form at the Underwriting/Funding 
or Customer Service/Collection master tab.

Setup Contains the following commands:
Administration - Allows you to open the 
Administration form at the System or User mas-
ter tab.
Products - Allows you to open the Product 
Setup form at the Setup, Loan master tab.
Queues - Allows you to open the Queue Setup 
form at the Setup, Origination, or Customer Ser-
vice master tab.
Correspondence - Opens the Correspondence 
form.
Events - Allows you to open the Events form at 
the Loan master tab.
Credit Bureau - Allows you to open the Credit 
Bureau Setup form at the Request or Reporting 
master tab.
Batch Jobs - Opens the Utilities form. 
Producers - Opens the Producer Management 
form.
Vendors - Opens the Vendor Management form.
Subvention - Opens the Subvention form at the 
Loan master tab.
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Escrow - Opens the Escrow Setup form at the 
Loan master tab.
Securitization - Opens the Securitization form.
General Ledger - Opens the General Ledger 
form.

Window Contains the following commands:
Cascade - Arranges the open forms on your 
screen so that they overlap, with the active form 
on top.
Tile Horizontally - Arranges the open forms on 
your screen so that they appear one on top of 
another.
Tile Vertically - Arranges the open forms on 
your screen so that they appear one next to 
another.
Note: The lower portion of the menu displays the 
Oracle Daybreak forms you have opened. You 
can use this menu to move between forms by 
selecting a specific form.

Help Contains the following commands:
Keys - Opens the Keys dialog box, containing a 
listing of all the hot keys available for the current 
form in use. Hot keys are shortcuts that perform 
Oracle Daybreak tasks with a minimum of key-
strokes.
Display Error - Displays information about 
recently encountered Oracle errors. (i-flex solu-
tions Corp. requests that you create a screen shot 
of this information and send it to us when you 
have a system error.)
Debug - Contains two commands: Set On and 
Set Off.
Oracle Daybreak Help - Allows you to open a 
browser and view .pdfs of either the User Guide 
or Setup Guide.
Oracle Daybreak On the Web - Allows you to 
open the i-flex solutions home page and report to 
Technical Support department when you encoun-
ter an error.
About Oracle Daybreak and Audit - Opens the 
About Oracle Daybreak dialog box, displaying 
version and audit information such as object data 
and recent updates. It also allows you access the 
column audit.

Oracle Daybreak toolbarThe row beneath the menu bar containing 19 icon buttons used 
to perform tasks and carry out commands. The toolbar buttons are 
labeled with the action they perform. To view the label, use the 
A-7    User Guide - Consumer Loans Collection



mouse to place the mouse pointer on the button without clicking 
and the label appears.

If you choose: (hot key) Oracle Daybreak will:

[A] Save Changes (F10) Save any pending changes on the 
form.

[B] Print (SHIFT + F8) Print the current screen.
[C] Exit (CTRL + E) Close the current form or exits the 

application.
[D] Cut (CTRL+X) Remove selected text and stores it 

on the clipboard.
[E] Copy (CTRL+C) Copy selected text and stores in on 

the clipboard.
[F] Paste (CTRL+V) Insert text stored on the clipboard 

in a selected field.
[G] Enter Query (F7) Change Oracle Daybreak to Enter-

Query mode.
[H] Execute Query (F8) Perform the query entered while in 

Query mode.
[I] Cancel Query (CTRL+Q) Change Oracle Daybreak back to 

user mode.
[J] First Record Display the first record.
[K] Previous Record (SHIFT + UP) Display the previous record.
[L] Next Record (SHIFT + DOWN) Display the next record.
[M] Last Record Display the last record.
[N] Insert Record (F6) Create a new record.
[O] Remove Record Delete the current record from the 

database.
[P] Clear Record (SHIFT+F4) Clear the current record from the 

form. 
[Q] Lock/Unlock Record Lock and unlocks a record.
[R] Copy with Details Record Copy the selected record to the 

clipboard.
[S] Help (CTRL + H) Display help for the selected item.

Note: Depending on the context of the selected field, some toolbar buttons may not be 
available. For example, if you select a field that does not allow a query, the Enter Query 
button is unavailable.

Message lineThe message line is located in the lower left corner of the Oracle Daybreak 
window and displays field prompts, error messages, or additional details about a field. In 
the illustration below, the message line contains the error message: “Query caused no 
records to be retrieved.”
A-8    User Guide - Consumer Loans Collection 



Status line The status line appears below the message line and displays status 
information about the current form or field. A status line can con-
tain the following indicators:

Enter-Query Indicates that Oracle Daybreak is in Enter-Query 
mode, allowing you to specify search criteria for 
a query.

List of Values Appears when a List of Values (LOV) is avail-
able for the selected field.

Form components
This section presents an overview of the components found on forms and how to use them.

Tab Oracle Daybreak uses tabs as a primary navigation tool. 

Tabs are small flaps used for quick access to pages of informa-
tion, not unlike the tabs on a folder in your file cabinet. There are 
three types of tabs in Oracle Daybreak system: master tab, tab, 
and sub tab. 

Master tabs are the highest level of tab. If present on a form, they 
are usually numbered and appear near the top of the form. Master 
tabs are used primarily to navigate to other pages. 

Tabs and sub tabs open pages that contain information. 

Sub tabs, if present, appear at the bottom of the form.
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Page (or tabbed page) The information items associated with a tab (blocks, records, 
check boxes, command buttons, and so on) are located on a page. 
The name of the page is the same as the name of the tab. The 
information associated with a sub tab is a sub page. 

In the illustration below, the Primary page and Address sub pages 
are is circled.
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Block A frame, or box, that encloses a set of related functions or data. A 
shadowed line marks a block’s perimeter. The title of the block 
appears across the top of the block in bold, black text. 

Command button A rectangle button that initiates a predefined action. Buttons do 
not contain values as fields do. A button is usually labeled with 
text noting the action that it performs. In the illustration below, 
the Loan page contains six command buttons: “Calculate,” 
“Amortize,” “Initialize,” “Copy to Decision,” “Copy to Con-
tract,” and “Print Report.” All three are located in the Action 
block.

Note: The “Copy to Contract” button is unavailable.

Field A box on a form used to enter, view, update, or delete informa-
tion. Each page contains fields. Fields can display values in dif-
ferent formats; including text, numbers, and dates.

Text field A field that stores characters and numbers.

Number field Number fields store only numbers, often dollar 
figures, with or without decimals.

Date field Date fields store dates and sometimes time val-
ues.

IMPORTANT: 
When you select a field, messages appear in the message area in 
the lower left corner of the Oracle Daybreak window. The mes-
sages describe the field or what type of information can be 
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entered in the field. (See Message line and Status line later in this 
section for more information.)

Option button A round button used to select an action from a group of options. 
You can select only one option button in a group at a time. In the 
illustration below, option buttons are used to select whether Ora-
cle Daybreak calculates payment or calculates interest rate. 

Check box A check box indicates a state for a particular field, such as 
enabled/disabled, primary/secondary, and current/not current. For 
that reason, check boxes are sometimes called “indicators.” The 
title of the check box indicates what it controls. A check denotes 
that the check box is selected. Click a selected check box to 
“clear” it. 

Note: One or more check boxes can be selected, since each one 
acts independently.

List of Values (LOV) A dialog box linked to a field that enables you to select a single 
item from a predefined list. To view a field's List of Values, press 
F9. Move the blue highlighted bar using the UP or DOWN ARROW 
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keys or the slide bar on the LOV dialog box to the value you want 
to select. In the example below, 55001 AFTON MN is selected. 
Some LOV contain lists long enough to require a scroll bar to 
view the entire contents. Choose OK, press ENTER, or double-
click the LOV item to populate the field with the selected value. 

Blue square (cursor) Oracle Daybreak uses a blue square as a cursor. The blue square 
indicates the active item, usually a field or record. You can move 
the blue square using the arrow keys on your keyboard or by 
clicking an item with the mouse.

Record A logically related collection of fields within a block about one 
person, place, or thing.

There are two types of records in Oracle Daybreak; table records 
and block records. A scroll bar allows you view records not cur-
rently displayed. The message bar informs you of the total num-
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ber of records in the table block, as well as the record you are 
currently viewing.

Table records Appear as a grid, where each record is a single 
row of related data.

Block records Record appears as a single block.

Record line Located in the lower left corner of the Oracle 
Daybreak window, the record line displays how 
many records exist within the record on display.

Next Record/ The presence of a record scroll bar indicates that 
Previous there are records above or below the one on
Record which you are working. If the scroll bar does not
scroll bar stretch the entire length between the two arrows, 

this indicates there are additional records avail-
able. If the scroll bar stretches the entire length 
between the two arrows this indicates no other 
records are available. Click the arrows to view 
these records. Click the up ( ) or left ( ) arrow 
for previous records. Click the down ( ) or right 
( ) arrow for following records.

Hint box A yellow box that appears when the mouse pointer is moved over 
a field. The hint box will display a description of the field’s con-
tent. If the field is associated with a List of Value dialog box, the 
hint box displays the Lookup Type of the LOV.

Using colors as a guide
Fields appear in different colors to indicate what type of information the field contains. 

Aqua Required - Information is required in an aqua field to complete a 
form.

White Optional - A white field is not required to contain information 
when completing a form. 

IMPORTANT:
Some optional fields may be required by your organization. Such 
fields, though not mandatory on the form, must be completed dur-
ing edit verification.

Gray Display only - Data cannot be entered in these fields. 

Note: Aqua, white, and gray are the default colors in the Oracle 
Daybreak system. Your organization may have selected different 
colors during implementation.
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Understanding parent-child relationships
A parent-child relationship is an association between a master block and one or more 
detail pages. The master-detail relationship is arranged in the shape of a pyramid, from the 
top of the form to the bottom. The top block contains the basic, or master, information. 
The detail pages then expand on the contents of the master block. Detail pages themselves 
can serve as master blocks for other sub detail pages that follow. When a block and pages 
are linked in a master-detail relationship, the following conditions exist:

1 The detail page displays only those records that are associated with the current record 
in the master block.

2 Querying between the master block and detail pages is always coordinated.

When a record is displayed in a master block, the detail pages contain information that 
corresponds to that record. If you perform query or change information in the master 
block, Oracle Daybreak updates the detail pages to match the new record in the master 
block. If you use the master block to perform a query and gain access to the records for a 
different application, the detail pages refresh to display information for the new record in 
the master block.

Note: You can perform a query from a detail page if the master block (or page) is com-
pleted. Otherwise, it is not possible to directly query from a detail page.

Example: Parent-child relationship
In the illustration below, note that the Underwriting form is divided into three sections. 
The top section (the Application block) is the master page. It contains such information as 
application number, product, and other items related to a specific application. The Appli-
cants (2) master tab has been selected to display the Primary page and Address Informa-
tion sub page. These detail pages contain further information about the application; in this 
case, the application’s primary applicant and that person’s address information.
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APPENDIX B :NAVIGATING AND QUERYING IN ORACLE DAY-
BREAK

This appendix explains how to use Oracle Daybreak to complete these frequently com-
pleted tasks:

• Navigate within and between forms
• Print a form
• Save an entry
• Edit data (including cutting, copying, and pasting data)
• Clear data
• Duplicate data
• Create and delete records
• Use the Editor dialog box
• Enter and query data using the List of Values (LOV) dialog box
• Use additional LOV tools (auto reduction, long-list, list search, and power list)
• Query data
• Use query operators and wildcard characters (including Query by example, Query/

Where, and Query count)
• Use hot keys.
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Navigating within a form
The following procedures can be used to navigate within a Oracle Daybreak form. Choose 
the one you are most comfortable using:

• Move the cursor with your mouse
• Select a command from the menu bar (Navigation menu)
• Select a command from the Oracle Daybreak toolbar
• Enter a keyboard shortcut (hot key)

The Navigation menu
The Navigation menu contains the following commands, all of which allow you to navi-
gate within a form: Block, Record, and Field.

The Block command contains the following sub commands:

If you choose: (hot key) Oracle Daybreak will:

Previous (CTRL + PAGE UP) Move the cursor to the previous block (if one 
exists).

Next (CTRL + PAGE DOWN) Move the cursor to the next block (if one exists).
Clear (SHIFT + F5) Clear the block currently containing the cursor.

The Record command contains the following sub commands:

If you choose: (hot key) Oracle Daybreak will:

Previous (SHIFT + F8) Display the previous record (if one exists).
Next (SHIFT + DOWN) Display the next record (if one exists).
Scroll Up (PAGE UP) Perform that same action as pressing PAGE UP.
Scroll Down (PAGE DOWN) Perform that same action as pressing PAGE 

DOWN.
Insert (F6) Create a new record.
Remove (SHIFT + F6) Remove the current record.
Duplicate (F4) Duplicate the current record.
Clear (SHIFT + F4) Clear the current record.

The Field command contains the following sub commands:

If you choose: (hot key) Oracle Daybreak will:

Previous (SHIFT + TAB) Move the cursor to the previous field (if one 
exists).

Next (TAB) Move the cursor to the next field (if one exists).
Clear (CTRL + U) Clear the current field.
Duplicate (F4) Duplicate the current field.

IMPORTANT:
The TAB and ENTER keys move the cursor between fields. F8 refreshes the record.
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Navigating between forms
You can open multiple forms in each window and navigate between them with the Win-
dow menu. The lower part of the Window menu lists the forms that are currently open. 
Selecting the form’s option button moves you to that form.

To navigate between forms

1 On the Oracle Daybreak menu bar, choose Window.

2 Select the form you want to move to by selecting it with one of the following methods:

• Click the option button for the corresponding form. 
-or-

• Move the cursor on the open Windows menu with the UP and DOWN ARROW keys and press 
ENTER to open a highlighted form.
-or-

• Type the number on the Windows menu next to the form you want to open.

Oracle Daybreak displays the form you selected.

Common Oracle Daybreak tasks
This section explains tasks common to many Oracle Daybreak modules and forms. Here 
you will learn how to:

• Print a form
• Save your work
• Editing data
• Using the Editor dialog box
• Close a form/leave Oracle Daybreak

Printing a form
You can print a form at any time. Make sure a printer driver is installed and at least one 
printer is defined before printing. (Contact your system administrator for information on 
how to install printer drivers and define printers.)

To print a window

• On the File menu, choose Print
-or-

• Click Print on the Oracle Daybreak tool bar.
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Saving your entry
When you save your work, the database is updated with all changes made since the last 
time the data was saved. 

To save your work in Oracle Daybreak

• On the File menu, choose Save
-or-

• On the Oracle Daybreak tool bar, choose Save (the yellow disk icon)
-or-

• Press F10.

When you save an entry, the message line at the bottom of your screen displays a “Trans-
action complete” message to inform you of the changes.

Editing data
In this section, you will learn how to use Oracle Daybreak to edit data. You will learn how 
to:

• Cut, copy, and paste data
• Clear data
• Duplicate data
• Create and delete records
• Use the Editor dialog box

Cutting, copying, and pasting data
The cut, copy, and paste commands on the Oracle Daybreak menu bar allow you to move 
and edit data. 

To cut, copy, and paste with the Oracle Daybreak menu bar

1 Open the form and select the data in the field you want to edit. (You can either drag your 
mouse over the data or double-click the data to select it.)

2 On the Edit menu, select Cut or Copy. (Copy leaves the data in the field while copying it; 
Cut clears the field when it copies the data.)

3 Move the cursor to the field where you want to place the copied data. 

4 On the Edit menu, choose Paste.

Oracle Daybreak pastes the cut or copied data in the new field.
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Keyboard guide for the previous steps

These three tasks can also be completed with the keyboard by doing the following:

Press this: To do this:

CTRL+X Cut
CTRL+C Copy
CTRL+V Paste

Clearing data
You can clear data from a form at any time. The data you clear is simply erased from the 
form, not deleted from the database. You can clear fields, records, blocks, or entire forms. 
This is particularly useful when you went to add an new entry to a record, block, or form 
that appears “full.”

If the data is new and has never been saved in the database, it will be permanently lost 
when you clear it from the form. Some items cannot be cleared of information. If you 
attempt to clear an item that cannot be cleared, the error message “Field is protected 
against update” appears in the message line.

To clear a field

• Select the field you want to clear and use one of the following methods to clear data:

On the Navigation menu, choose Field > Clear.
-or-
Select and type over the existing data, or use the BACKSPACE or DELETE key to remove the 
data.
-or-
Press CTRL+U.

IMPORTANT:
The data you clear from the field is not available for pasting into another field. If you want 
to paste the data elsewhere, use the Copy or Cut commands on the Edit menu.

To clear a record 

• Select the record you want to clear and use one of the following methods to clear data:

On the Navigation menu, choose Record > Clear.
-or-
On the Oracle Daybreak tool bar, choose the Clear Record icon.
-or-
Press SHIFT+F4.

Oracle Daybreak clears the values in all the fields of your current record and returns the 
cursor to the first field of the next record.

To clear the current block

• Select a field in the block you want to clear and use one of the following methods to clear 
data:

On the Navigation menu, choose Block > Clear.
-or-
Press SHIFT+F5.
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Oracle Daybreak clears the block and returns your cursor to the first field in the current 
block.

IMPORTANT: 
If the current block is a multi-record block, this action erases all records displayed in the 
block.

To clear a form

• Open the application of the form you want to clear and press SHIFT+F7.

Oracle Daybreak clears the data from all the fields of the current form and returns your 
cursor to the first field of the form.

Duplicating data
If data needs to be repeated in a new record, you can duplicate data from a previous 
record.

To copy a field from a previous record

1 Depending on the form you are using, enter a new record or query an existing record.

2 On the Navigation menu, choose Record > Insert
-or-
On the Oracle Daybreak tool bar, choose the Insert Record icon
-or-
Press F6.

Oracle Daybreak inserts a new record after the existing record.

3 Move the cursor to the field you want to duplicate in the new record.

4 On the Navigation menu, choose Field > Duplicate.
-or-
Press F3.

Oracle Daybreak copies the field value from the previous record to the current record.

To copy all fields from a previous record

1 Enter a new record, or query an existing record in your form.

2 On the Navigation menu, choose Record > Insert
-or-
On the Oracle Daybreak tool bar, choose the Insert Record icon
-or-
Press F6.

Oracle Daybreak inserts a new record after the existing record.

3 On the Navigation menu, select Record > Duplicate.

-or-
Press F4.
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IMPORTANT: 
If your current block requires all records to be unique, the Duplicate command does not 
duplicate those fields that must be unique.

To copy all information on a page and its sub pages

1 Move the cursor to the first field on the page you want to duplicate.

2 On the Oracle Daybreak tool bar, choose the Copy with Details Record icon.

Note: For this process to work, the entry has to be locked (lock parameter set to y)

3 Make the changes you desire to the details in the duplicate entry to make it unique.

4 Choose the Copy with Details Record icon to complete sub tabs.

5 Make the changes you desire to the sub page details in the duplicate entry to make it 
unique.

6 Save your new entry.

Creating and deleting records
You can enter new records in the database or delete existing records from the database. 
Only users who have the appropriate permissions set up in their user responsibility can 
create or delete records.

To create a new record

1 On the Navigation menu, choose Record > Insert.
-or-
On the Oracle Daybreak tool bar, click Insert Record.
-or-
Press F6.

Note: When you create a record in a multi-record block, Oracle Daybreak inserts a new 
blank row below the selected row. In a single-record block, Oracle Daybreak clears the 
fields in the block. 

2 Once the selected field is cleared, enter the data for the new record. 

3 On the File menu, choose Save.
-or-
On the Oracle Daybreak tool bar, click Save.
-or-
Press F10.

Oracle Daybreak saves the record in the database.

IMPORTANT: 
If you exit the form without saving your work, the record is not added to the database.
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To delete a record 

1 Select the record you want to delete. 

2 Use one of the following methods to delete data from a field:

On the Navigation menu, choose Record > Remove.
-or-
On the Oracle Daybreak tool bar, choose the Remove Record icon.

Oracle Daybreak erases the current record from your form and returns your cursor to the 
first field of the next record; however, the record is not yet deleted.

3 On the File menu, choose Save.
-or-
On the Oracle Daybreak tool bar, click Save.
-or-
Press F10.

IMPORTANT:
If you exit the form without saving your work, the record is not deleted from the database.
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Using the Editor dialog box
You can use the Editor dialog box to view, enter, or update the entire contents of an entry 
field. The Editor dialog box is especially useful for editing scrollable text fields. A scrolla-
ble text field is a field whose actual width is longer than its display width and whose con-
tent you can view by scrolling through the field. Searches performed in the Editor dialog 
box are case-sensitive.

IMPORTANT:
If a text field is set up to use a default system editor, then the following procedures open 
the editor determined by the profile option “Editor (Character).”

To use the Editor dialog box

1 Open the form and select the field you want to edit.

2 On the Edit menu, choose Edit Field.

The Editor dialog box appears with the text from the field you selected.

Note: You can also open the Editor dialog box by pressing CTRL+E.

3 Enter a new text or edit the existing text in the Editor dialog box and choose Ok.

IMPORTANT: 
If the current field is a display-only field, then the Editor dialog box appears in display-
only mode.

To search for a phrase and replace it with another phrase

1 On the Edit menu, choose Edit Field.

The Editor dialog box appears.

2 Choose Search.

The Search/Replace dialog box appears.
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3 In the Search for field, type the text or characters you want to find on the form.

If you want to replace that data with other data, type the new data in the Replace with 
field.

4 Choose the Search button to search for the value.
-or-
Choose Replace to search for the value and replace the first occurrence.
-or-
Choose Replace All to search for the value and replace all occurrences.

5 To close the Search/Replace dialog box, choose Cancel.

6 When you are finished editing the value in the Editor window, choose Ok.

The Editor dialog box closes the window and the edited value appears in the field.

Exiting a form/leaving Oracle Daybreak
You can close a Oracle Daybreak form, or end a Oracle Daybreak session, using the mouse 
or keyboard.

To save exit a form/leave Oracle Daybreak

• On the File menu, choose Exit
-or-

• On the Oracle Daybreak tool bar, choose Exit (the blue door icon)
-or-

• Press CTRL + Q.

Oracle Daybreak will end a Oracle Daybreak session when you perform one of these 
actions from the Login form.

Entering and querying data
This chapter explains how to use the List of Values dialog boxes and search for data while 
using a form.

List of Values (LOV) dialog box
Many fields on Oracle Daybreak forms are linked to a List of Values (LOV) dialog box. 
An LOV displays all possible entries that Oracle Daybreak will accept for a particular 
field. You can select data from the LOV to complete the field instead of having to search 
for acceptable entries. Likewise, a field that is associated with an LOV only accepts 
entries found on the list of values. Using the LOV increases accuracy and productivity, as 
it ensures uniformity and efficiency during data entry.

Note: If you are in Enter-Query mode, the LOV cannot be used.
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When an LOV is available for a field, “List of Values” appears on the status line. Also, 
when you move the cursor to the field with an LOV from a Lookup field in the Setup 
menu, a yellow hint box appears, citing the lookup type for the LOV.

When you open an LOV from an entry field, the field’s LOV dialog box appears.

An example of a List of Values box. This one appears from the Street Type field on an 
Address block.
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An LOV might contain more than one column of information. Most LOVs provide a 
descriptive heading at the top of each column. 

To select data from an LOV

1 Move the cursor to an entry field with an LOV.

“List of Valu...” appears on the status line.

2 On the Edit menu, choose List of Values.
-or-
Press F9.

When the LOV appears, you can either use the mouse to scroll through the list box and 
double-click on a value to select it, or press the UP ARROW or DOWN ARROW keys to high-
light a value with the blue bar. 

If you choose Cancel, the LOV closes and no entry appears in the field.

3 Press ENTER or choose OK to select the value.

Once you select a value, the LOV dialog box closes and the selected value appears in the 
field. 
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Additional LOV tools 
In addition to allowing you to select a field value, LOVs provide tools to simplify entering 
data and working with long lists. Auto Reduction lets you view a condensed portion of the 
entire list of values. Power List allows you to quickly enter data without opening the LOV.

In some cases, an LOV is too large to fit entirely in the list box and the Long-List LOV 
appears. 

Auto reduction
Using Auto Reduction, you can shorten an LOV. With a shortened list, you only need to 
scan a subset of the original values. 

To use the Auto reduction feature

• In the Find field on the LOV dialog box, type the first character(s) of a value you want to 
locate. (A percent sign appears by default in the Find field.)

Oracle Daybreak automatically reduces the list to just those values in the first column that 
match the characters you enter. 

Note: To return to the entire contents of the LOV, type the wildcard character % in the 
Find field and press ENTER.

List search
If you do not know the initial characters of your value, but do know that your value con-
tains a certain word or set of characters, you can perform a list search to find the values 
that contain those words or characters.

To perform a list search

1 In the Find field on the LOV dialog box, enter any group of characters as search criteria. 
Use wildcard characters, such as the percent sign (%), which represents any number of 
characters, or underline ( _ ), which represents a single character in your search criteria.

IMPORTANT:
The criteria you enter for a list search is not case-sensitive. For example, to reduce a 
search list to just those values containing the word “schedule,” enter %schedule% in the 
Find field.

2 Choose Find. 

A reduced list appears, containing just those values that match the search criteria.
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Long-list
Long-List is the other tool you can use to shorten an LOV. Long-List works similarly to 
Auto Reduction. The Long-List dialog box appears when a field has a list too large for 
Auto Reduction. 

To perform a list search

1 In the Find field on the long list LOV dialog box, type the first few characters that occur in 
your value in the Find field

2 Choose Find.

Oracle Daybreak reduces the long list to a smaller sub set of values meeting the search cri-
teria in the Find field in a regular LOV.

3 Select the value you want to use and choose Find. 

 Other LOV features
You do not have to use a field’s LOV to complete a field. If your entry appears in the 
field’s’ LOV, Oracle Daybreak will accept it when you type it in the field.

The Auto Reduction logic that applies to the LOV also applies to your entry in a field with 
an LOV. If you type the first letter of your entry and press TAB, Oracle Daybreak will auto-
matically complete the field if there is a single match in the LOV.

If more than one entry in the LOV share the characters you typed, Oracle Daybreak will 
open the LOV displaying only the entries beginning with those characters.

If no entry in the LOV matches the characters you typed, Oracle Daybreak opens the LOV 
displaying all of its entries when you press TAB.
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Querying data
Oracle Daybreak provides you with search options to locate information when working 
with a form. You can retrieve and review all available information in your database with-
out having to remember the information from a previously displayed form or printing 
lengthy reports to view an item. Instead, you can perform a search to obtain and review the 
information you want.

This section describes the methods you can use to locate and retrieve records in Oracle 
Daybreak. These include:

• Using query operators
• Query-by-example
• Query/Where
• Using query count

Note: If you are in Enter-Query mode, the LOV cannot be used.

IMPORTANT: 
Searches cannot be performed in forms that require using the Search page to retrieve infor-
mation. These forms (for example, the Underwriting form, the Funding form, and Cus-
tomer Service form) only display run-time output, or only run specific processes. The 
following message appears in the message line if you attempt to search such a form: 
“Function key not allowed. Press Ctrl+F1 for list of valid keys.”

Using query operators
Query operators are used to create search criteria to limit searches to specific information. 
The query operators available in most fields include:

Operator Meaning Example Expression

= equal to = 'Janet' or = 107
!= not equal to != 'Bob' or != 107
> greater than > 99 or > '01-JAN-93'
>= greater than or equal to >= 55
< less than < 1000.00
<= less than or equal to <= 100
#BETWEEN between two values #BETWEEN 1 AND 1000

The query operator expressions retrieve results according to character-ordering rules for 
character fields and numeric-ordering rules for numeric fields. For example, look at the 
following field values:

002, 003, 004, 005, 078, 123, 253, 441, 576, 775, 1274, 3298, 
4451, 5600, 9578, 10500, 58437, 708445
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These values are shown in the order you expect for numeric values, where 005 is between 
004 and 078. If the field is defined as a numeric field, then the phrase “#BETWEEN 004 
AND 078” would retrieve 004, 005, and 078.

However, if the field is defined as a character field, then the phrase “#BETWEEN 4 AND 
7” would retrieve the values 441, 576, 4451, 5600, and 58437, which all start with 
characters between 4 and 7. The values 775 and 005 would not appear because 775 is 
lexically greater than 7, and 0 is lexically less than 4.

Some fields contain date values that are actually “Date-format” character values. These 
fields act like character fields in that the value 01-FEB-92 would be lexically less than 01-
JAN-92, because F precedes J in a character set.

IMPORTANT: 
Sometimes you cannot instantly determine if a field containing numeric values is defined 
as a character or numeric field. To identify what the field type is, you may have to enter 
and experiment with different search criteria expressions and see what results are returned.

Tips for using Query Operators
• Use single quotation marks ('  ') to enclose the character or date value in your 

expression. For example:

'Texas'
'01-MAY-93'

• Query operators cannot be used in time fields.

When you use the #BETWEEN query operator, the search criteria “#BETWEEN value1 
AND value2” retrieves all records containing values between and including value1 and 
value2. The same applies to dates. For example, using the search criteria “#BETWEEN 
'01-JAN-93' AND '01-MAR-93'” in a date field retrieves all records with dates between 
and including January 1, 1993 and March 1, 1993.

Finding patterns with wildcard characters
In addition to query operators, you can include wildcard characters in your search criteria. 
Wildcard characters search for particular patterns in your data. Use the percent (%) wild-
card character within a field to represent any number of characters (including no charac-
ters), or use the underline ( _ ) wildcard character to represent any single character. 

For example, if you want to retrieve all records that contain the word “XXX” in a specific 
field, you would enter the search criteria %XXX% in that field.
Appendix B :-16    User Guide - Consumer Loans Collection 



Enter-Query mode
If you want to retrieve a group of records in a Oracle Daybreak from using search criteria, 
you can use Enter-Query mode.The Enter-Query mode may be used to specify complex 
search criteria in any of the fields on your current block. 

The search criteria can include:

• Specific values
• Phrases containing wildcard characters
• Phrases containing query operators 
• Any combination of the three to help you pinpoint the data of interest.

IMPORTANT: 
When your application is in Enter-Query mode, you will not be able to navigate out of the 
current form. To navigate from the form, you must exit Enter-Query mode by choosing 
Cancel Query or Exit on the task bar or pressing CTRL+Q.

To user Query-by-example

1 On the Query menu, choose Enter
-or-
Press F7
-or-
On the Oracle Daybreak toolbar, click the Enter Query icon.

Oracle Daybreak switches from data entry mode to Enter-Query mode and clears the form. 
The Enter-Query message appears in the status line. 

2 Enter search criteria in any of the fields, using wildcard characters and query operators as 
necessary. You can also choose Last Criteria on the Query menu to display the search cri-
teria used in your last search, if there was one.   

Note: Pressing F7 twice will also display the search criteria from your last search.

IMPORTANT: 
While in Enter-Query mode, all check boxes are in a neutral state; that is, they are neither 
selected nor cleared as a default. If you want your search criteria to include a selected 
check box, you have to select it, regardless of whether it already appears to be checked. 
Similarly, if you want your search criteria to include a cleared check box, you have to clear 
it, regardless of how it currently appears. (To clear it, first select the check box to activate 
it, then select it again to clear it.)

3 On the Query menu, choose Execute
-or-
Press F8
-or-
On the Oracle Daybreak toolbar, click the Execute Query icon.

IMPORTANT: 
To retrieve all the database records for a block, you can bypass steps 1 and 2 and select 
Execute on the Query menu. This is known as a blind query. To retrieve all records for a 
block, press F7, then press F8 to perform the query.
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4 To leave the Enter-Query mode, choose Cancel from the Query menu
-or- 
Press CTRL+Q
-or-
On the Oracle Daybreak toolbar, click the Cancel Query icon.

Query/where 
An even more sophisticated search method is to use Query/where. Query/where allows 
you to modify a query by using a SQL Plus statement as your search criteria.

To use Query/where

1 On the Query menu, choose Enter
-or-
Press F7
-or-
On the Oracle Daybreak toolbar, click the Enter Query icon.

Oracle Daybreak switches to Enter-Query mode.

2 Enter the character & (or a blind variable) in the field from which you want to run the 
query.

3 On the Query menu, choose Execute
-or-
Press F8
-or-
On the Oracle Daybreak toolbar, click the Execute Query icon.

The Query/Where dialog box appears.

4 Type the search criteria in the format of a SQL Plus statement in the window. 

For example, the following Query/Where search criteria:

:P like '%VEH%' and :A in ('0000000374', '0000000532')

Would produce the following results:

The two loan loans, 0000000374 and 0000000532.

5 Choose OK to execute the query. 
-or-
Choose Cancel to close the Query/Where dialog box without running a query. 

Note: If you have a long statement as your search criteria, you can use a field editor to 
make changes to your statement by choosing Search. 
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Query count 
If you do not need to retrieve the records from a query-by-example search, but only want 
to know how many records match your search criteria, you can perform a query count.

To obtain a count of the number of records

1 On the Query menu, choose Enter
-or-
Press F7
-or-
On the Oracle Daybreak toolbar, click the Enter Query icon.

2 Enter the search criteria in the field you want to perform the query.

3 On the Query menu, choose Count Hits.
-or-
Press SHIFT+F2.

Oracle Daybreak counts your query. A message appears on the message line displaying 
the number of records query-by-example would retrieve if you ran the search.

IMPORTANT: 
If you select Count Hits on the Query menu without specifying any search criteria in a 
block, query count displays the total number of records in the database for that block.
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Hot keys
“Hot keys” are keystroke shortcuts that perform navigation and data entry tasks. A dialog 
box containing a form’s available hot keys can be viewed by selecting Help > Keys on the 
Oracle Daybreak menu bar. Below is a list of these keys:

Function Key(s)
Block Menu F5
Cancel Query CTRL + Q
Clear Block SHIFT + F5
Clear Field CTRL + U
Clear Form SHIFT + F7
Clear Record SHIFT + F4
Copy CTRL + C
Count Query SHIFT + F2
Cut CTRL + X
Delete Record SHIFT + F6
Display Error SHIFT + F1
Down DOWN ARROW
Down CTRL + L
Duplicate Item F3
Duplicate Previous Record F4
Exit CTRL + E
Enter Query F7
Execute Query F8
Help CTRL + H
Insert Record F6
List Tab Pages F2
Move between master tabs

Master tab 1 SHIFT + CTRL + F1
Master tab 2 SHIFT + CTRL + F2
Master tab 3 SHIFT + CTRL + F3
Master tab 4 SHIFT + CTRL + F4
Master tab 5 SHIFT + CTRL + F5
Master tab 6 SHIFT + CTRL + F6
Master tab 7 SHIFT + CTRL + F7
Master tab 8 SHIFT + CTRL + F8
Master tab 9 SHIFT + CTRL + F9
Master tab 10 SHIFT + CTRL + F10

Move to next page/sub page CTRL+TAB
Move to previous page/sub page CTRL+SHIFT+TAB
Next Block/Page to sub page CTRL + PAGE DOWN
Next Field TAB
Next Primary Key SHIFT + F3
Next Record SHIFT + DOWN ARROW
Next Set of Records SHIFT + CTRL + PAGE DOWN
Paste CTRL + V
Previous Block/Sub page to page CTRL + PAGE UP
Previous Field SHIFT + TAB
Previous Record SHIFT + UP ARROW
Print SHIFT + F8
Return ENTER
Save changes F10
Scroll Down PAGE DOWN
Scroll Up PAGE UP
Scroll Keys CTRL + F1
Up CTRL + P
Up UP ARROW

Update Record CTRL + U
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APPENDIX C : TRANSACTION PARAMETERS

The Customer Service form Maintenance (3) master tab allows you to post an array of 
monetary and nonmonetary transactions for any given account. The transactions that are 
available depend on the responsibility of the Oracle Daybreak user, the nature of the 
account, and whether the account is a loan.

This appendix catalogues the baseline transaction codes and parameters available on the 
Customer Service form’s Maintenance (3) master tab. Instructions on how to use the 
Maintenance (3) master tab are located in the Customer Service chapter of this User 
Guide.

Loan monetary transactions
This section catalogues the transaction codes and parameters required to complete the fol-
lowing monetary tasks for loans:

• Apply, adjust, or waive servicing expenses
• Adjust or waive late charges
• Adjust or waive nonsufficient funds
• Apply, adjust, or waive repossession expenses
• Apply, adjust, or waive bankruptcy expenses
• Apply or adjust phone pay fees
• Change an index/margin rate
• Apply, adjust, or cancel financed insurance
• Generate a payoff quote
• Payoff an account
• Charge-off an account
• Close an account
• Adjust, charge-off, or waive the advance/principal balance
• Adjust the interest balance
• Stop interest accrual
• Indicate a borrower as on or off active military duty
• Change a due date
• Apply, adjust, or waive an extension fee
• Change payment amount
• Adjust or waive a prepayment penalty
• Reschedule an escrow payment
• Adjust or waive an escrow payment
• Adjust or waive a payoff quote fee
• Place an account in a nonperforming condition
• Reverse a nonperforming condition
• Reschedule precompute loan to interest bearing loan
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Servicing expenses
Service expenses are any expenses incurred to service an account; for example, employing 
a courier to send documents, such as payoff quotes or balance statements. Servicing 
expenses appear in the Other Due field on the Dues block of the Account Details page. 
This is the first page to appear on the Customer Service form when you load an account.

To post a servicing expense
Transaction Parameters
SERVICING EXPENSES TXN DATE

AMOUNT

To adjust a servicing expense
Transaction Parameters
ADJUSTMENT TO SERVICING EXPENSES - ADD TXN DATE

AMOUNT

ADJUSTMENT TO SERVICING EXPENSES - SUBTRACT TXN DATE
AMOUNT

To waive a servicing expense
Transaction Parameters
WAIVE SERVICING EXPENSES TXN DATE

AMOUNT
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Late charges
Late charges occur when payment is not made within the grace period or by the day after 
payment is due. The due date is determined by the contract. Late charges cannot be 
assessed by a user, they are assessed automatically by Oracle Daybreak.

Late charges appear in the LC Dues field on the Dues block of the Account Details page. 
This is the first page to appear on the Customer Service form when you load an account.

To adjust a late charge 
Transaction Parameters
ADJUSTMENT TO LATE CHARGE - ADD TXN DATE

AMOUNT

ADJUSTMENT TO LATE CHARGE - SUBTRACT TXN DATE
AMOUNT

To waive a late charge
Transaction Parameters
WAIVE LATE CHARGE TXN DATE

AMOUNT
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Nonsufficient fund fees
Nonsufficient fund fees are posted when a payment does not cover the amount owed. The 
fee that Oracle Daybreak automatically applies to an account is recorded during setup.

Nonsufficient fund fees appear in the NSF Due field on the Dues block of the Account 
Details page. This is the first page to appear on the Customer Service form when you load 
an account.

To adjust a nonsufficient funds
Transaction Parameters
ADJUSTMENT TO NONSUFFICIENT TXN DATE
     FUND FEE - ADD AMOUNT

ADJUSTMENT TO NONSUFFICIENT TXN DATE
     FUND FEE - SUBTRACT AMOUNT

To waive a nonsufficient funds
Transaction Parameters
WAIVE NONSUFFICIENT FUND FEE TXN DATE

AMOUNT
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Repossession expenses
Repossession expenses include any costs incurred while obtaining the asset, including 
legal fees or storage costs.

Repossession expenses appear in the Other Due field on the Dues block of the Account 
Details page. This is the first page to appear on the Customer Service form when you load 
an account.

To post a repossession expense 
Transaction Parameters
REPOSSESSION EXPENSES TXN DATE

AMOUNT

To adjust a repossession expense
Transaction Parameters
ADJUSTMENT TO REPOSSESSION TXN DATE
     EXPENSES - ADD AMOUNT

ADJUSTMENT TO REPOSSESSION    TXN DATE
     EXPENSES - SUBTRACT AMOUNT

To waive a repossession expense
Transaction Parameters
WAIVE REPOSSESSION EXPENSES TXN DATE

AMOUNT
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Bankruptcy expenses
Bankruptcy expenses include any costs incurred when an account holder declares bank-
ruptcy, such as legal fees or additional collection costs.

Bankruptcy expenses appear in the Other Due field on the Dues block of the Account 
Details page. This is the first page to appear on the Customer Service form when you load 
an account.

To post a bankruptcy expense 
Transaction Parameters
LEGAL BANKRUPTCY EXPENSES TXN DATE

AMOUNT

To adjust a bankruptcy expense
Transaction Parameters
ADJUSTMENT TO BANKRUPTCY TXN DATE
     EXPENSES - ADD AMOUNT

ADJUSTMENT TO BANKRUPTCY TXN DATE
     EXPENSES - SUBTRACT AMOUNT

To waive a bankruptcy expense
Transaction Parameters
WAIVE LEGAL BANKRUPTCY EXPENSES TXN DATE

AMOUNT
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Phone pay fees
Phone pay fees are where a borrower calls the lender and arranges for a debit to their 
checking or savings account to make a payment on a loan account.

Phone pay fees appear in the Other Due field on the Dues block of the Account Details 
page. This is the first page to appear on the Customer Service form when you load an 
account.

To adjust a phone pay fee
Transaction Parameters
ADJUSTMENT TO PHONE PAY FEE - ADD TXN DATE

AMOUNT

ADJUSTMENT TO PHONE PAY FEE - SUBTRACT TXN DATE
AMOUNT

To waive a phone pay fee
Transaction Parameters
WAIVE PHONE PAY FEE TXN DATE

AMOUNT
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Financed insurances
You can add financed insurance to an existing account with the INSURANCE ADDITION 
transaction. This transaction adds the insurance premium amount to advance/principal bal-
ance on the loan and adjusts the loan receivables accordingly. The transaction also triggers 
the process to re-compute the repayment amount for the loan. After you post the transac-
tion, the loan will be billed for the newly computed payment amount and will be consid-
ered for delinquencies and fees calculations based on information on the Contract (7) 
master tab. The newly added insurance information can be viewed on Customer Service 
form’s Insurances page. 

To add financed insurance
Transaction Parameters
INSURANCE ADDITION TXN DATE

INSURANCE TYPE
SINGLE/JOINT
INSURANCE MODE
INSURANCE PLAN
COMPANY NAME
PHONE #1
EXTN #1
PHONE #2
EXTN #2
POLICY #
POLICY EFFECTIVE DATE
PREMIUM AMOUNT
EXPIRATION DATE
PRIMARY BENEFICIARY
SECONDARY BENEFICIARY
COMMENT

You can cancel financed insurance on an existing account with the INSURANCE CANCEL-
LATION transaction. When you post this transaction, Oracle Daybreak computes the pre-
mium refund amount based on the refund method associated with the insurance item. If 
you enter a value for the PREMIUM AMOUNT parameter, Oracle Daybreak overrides the 
calculated refund amount and adjusts the advance/principal balance and the loan receiv-
ables accordingly. The INSURANCE CANCELLATION transaction re-computes the repay-
ment amount for the loan based on remaining balances.   After posting the transaction, the 
loan will be billed for the newly computed payment amount according information on the 
Contract (7) master tab. The insurance cancellation information can be viewed on the Cus-
tomer Service form’s Insurances page on the Customer Service (2) master tab.

To cancel a financed insurance
Transaction Parameters
INSURANCE ADDITION TXN DATE

INSURANCE TYPE
POLICY EFFECTIVE DATE
INSURANCE REFUND
     AMOUNT
INTEREST REFUND
     AMOUNT
PAYMENT AMOUNT
CANCELLATION REASON
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You may rectify possible errors resulting from incorrect information entered on the 
INSURANCE ADDITION transaction (such as an incorrect premium account) with the 
monetary transaction INSURANCE MODIFICATION. 

When you post the INSURANCE MODIFICATION transaction, Oracle Daybreak re-com-
putes the repayment amount using the new premium amount and adjusts the advance/prin-
cipal balance on the loan and the loan receivables.

To modify financed insurance information
Transaction Parameters
INSURANCE MODIFICATIONS TXN DATE   

INSURANCE TYPE   
POLICY EFFECTIVE DATE   
PREMIUM AMOUNT   

Index/margin rates
You can change the current index rate type and margin rate of a variable rate loan using the 
INDEX / MARGIN RATE CHANGE monetary transaction.

To change an index/margin rate
Transaction Parameters
INDEX/MARGIN RATE CHANGE EFFECTIVE DATE

INDEX
MARGIN RATE
REASON
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Payoff quotes
A payoff quote is the amount still owed on the account or the amount needed to satisfy the 
loan. It can be generated anytime and may be requested during a call from a customer, 
dealer, or insurance agent. The payoff quote appears in the Results block of the Mainte-
nance (3) master tab.

To generate a payoff quote for an account (Loan)
Transaction Parameters
PAYOFF QUOTE TXN DATE

PAYOFF QUOTE VALID UP 
     TO DATE
ASSESS PAYOFF QUOTE FEE
PAYOFF QUOTE LTR PRINT
COMMENT
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Account payoff
An account is automatically paid off or marked for payoff processing by Oracle Daybreak 
with a batch transaction when the account balance is $0.00. You can also manually payoff 
an account with the Maintenance (3) master tab. Note: You can also pay off an account 
using the Consumer Lending (Advance and Payment) form. (For more information, see 
the Batch Transactions chapter.)

When you payoff an account, Oracle Daybreak changes the account’s status to PAID OFF. 
The date the account was paid off appears in the Activity block’s Paid Off Dt field on the 
Account Details page.

Oracle Daybreak also notes the amount of the principal that was waived when the account 
was paid off in the Waived column on the Balances page.

To pay off an account
Transaction Parameters
PAID OFF TXN DATE

If you reverse the payoff payment using the Customer Service form, then the pay-off is 
automatically reversed. Oracle Daybreak changes the account’s status from PAID OFF to 
ACTIVE when you refresh the account.
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Account charge off
Charging off an account refers to when a lender decides to take a loss on an account, sig-
naling that attempts to recover the loan have failed. In calculating a charge off, Oracle 
Daybreak considers the total compensation amount (up front compensation plus remaining 
compensation amount). 

When you charge off account, Oracle Daybreak changes the status to CHARGED OFF. The 
balance on the account appears on the Customer Service form’s Balance page when you 
choose Deficiency Balance in the Balance Group block.

The date of the charge off appears on the Account Details page in the Activity block’s 
Chargeoff Dt field.

Note: Charging off is a process of writing off a loss on a loan which is not repaid by the 
customer. It is different from the waive off process since a waive off is a concession 
offered to the customer on payment of some component, such as a late fee. The repayment 
of the original loan still continues in waive off process.

To charge off an account
Transaction Parameters
CHARGED OFF TXN DATE

Account closure
Oracle Daybreak automatically closes an account when its status changes to PAID or 
VOID. It is manually closed on charge off accounts. Accounts marked as CLOSED are not 
processed and after a period of time are purged from Oracle Daybreak.

Note: The ACCOUNT CLOSE transaction can not be processed on accounts with an 
ACTIVE status. Accounts with a status of CHARGE OFF can be closed.

To close an account
Transaction Parameters
ACCOUNT CLOSE TXN DATE

Advance (principal) balance
The advance (or principal) balance is posted automatically when you fund the contract on 
the Funding form or when you activate in the account in the Conversion App/Acc form. 
You are not allowed to post the advance with the Customer Service form. However, you 
can waive, charge off or adjust the advance or principal.

The adjustments will appears in corresponding column of the Customer Service form’s 
Balances page for the ADVANCE / PRINCIPAL Balance Type-- Waive, Charged Off, 
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Adjusted (-), or Adjusted (+) -- depending on which of the following the transactions you 
perform.

To adjust the advance/principal balance
Transaction Parameters
ADJUSTMENT TO ADVANCE/PRINCIPAL - ADD TXN DATE

AMOUNT

ADJUSTMENT TO ADVANCE/PRINCIPAL - SUBTRACT TXN DATE
AMOUNT

To charge off the advance/principal balance
Transaction Parameters
CHGOFF ADVANCE/PRINCIPAL TXN DATE

AMOUNT

To waive the advance/principal balance
Transaction Parameters
WAIVE ADVANCE/PRINCIPAL TXN DATE

AMOUNT

Interest
The interest is accrued or posted automatically when you post the payment on the Con-
sumer Lending (Advance and Payment) form. You cannot post the interest in the Cus-
tomer Service form; however, you can adjust or waive interest.
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The adjustments will appears in corresponding column of the Customer Service form’s 
Balances page for the INTEREST Balance Type-- Waive, Adjusted (-), or Adjusted (+) -- 
depending on which of the following the transactions you perform.

To adjust the interest 
Transaction Parameters
ADJUSTMENT TO INTEREST - ADD TXN DATE

AMOUNT

ADJUSTMENT TO INTEREST - SUBTRACT TXN DATE
AMOUNT

To waive the interest 
Transaction Parameters
WAIVE INTEREST TXN DATE

AMOUNT

Interest accrual
You can start or stop interest accrual on either a loan.

To start interest accrual for an account
Transaction Parameters
START ACCURAL TXN DATE
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To stop interest accrual for an account
Transaction Parameters
STOP ACCURAL TXN DATE 

On the Customer Service (2) master tab, on the Loan Details or LoC Details sub pages of 
the Balances, Transactions, and Tracking Attributes pages, the Stop Accrual box is 
selected in the Interest and Accruals block.

Note: To remove the Stop Accrual indicator, post the START ACCURAL transaction.

Active military duty
The Servicemembers Civil Relief Act of 2003 (SCRA), formerly known as the Soldiers 
and Sailors Civil Relief Act of 1940 (SSCRA), is a federal law that gives military mem-
bers some important rights as they enter active duty military service. The law is designed 
for active duty military personnel and reservists (and their spouse -- if applicable for joint 
credit accounts) to receive, as a result of military service economic hardship(s), an interest 
rate reduction (currently at 6.000%) for certain consumer and mortgage-related debt that 
was incurred prior to entering military service, for the period of time that the servicemem-
ber is on active duty. Under the law, the term’s interest includes service charges, renewal 
charges, fees, or any other charges (except bona fide insurance) with respect to an obliga-
tion or liability. The law also provides protection against certain legal actions during the 
term of active duty military service. The SCRA function is currently available in Oracle 
Daybreak for simple interest loan accounts.

Any account that has been identified under SCRA requirements as eligible for the allow-
able benefits of active military duty for its primary borrower/spouse will have a new inter-
est rate calculation based upon the 6.000% limit set by the SCRA. However, this change is 
subject to exception in case of accounts that already have an interest rate less than 6.000%. 
In such cases, the original interest rate that is less than 6.000% will continue.
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To indicate that a borrower is on active military duty
Transaction Parameters
BORROWER ON MILITARY DUTY TXN DATE

BORROWERS RELATION
    WITH ACCOUNT

ACTIVE DUTY ORDER REF-
   ERENCE

After you post this transaction, the Active Military Duty box (Customers block) and Mili-
tary Duty box (Activity block) are selected on the Customer Service (2) master tab’s 
Account Details page. Oracle Daybreak changes the condition of the account to ON 
ACTIVE DUTY. Details of the transaction appear in the Military Services block on the 
Customer Service (2) master tab’s Customer Details page.

If the interest rate was greater the 6%, Oracle Daybreak will change the rate to 6% and 
adjust the payment accordingly. The CHANGE PAYMENT AMOUNT and RATE CHANGE 
transactions on the Customer Service (2) master tab’s Transactions page.

To indicate that a borrower is no longer on active military duty
Transaction Parameters
BORROWER OFF MILITARY DUTY TXN DATE

BORROWERS RELATION
    WITH ACCOUNT
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Due date change
You can change the due date of an account. If a late fee is no longer applicable because of 
this due day change, Oracle Daybreak will automatically remove the fee.

Note: When you change a due date, Oracle Daybreak determines the next bill date, as well 
as the next due date. The DUE DATE CHANGE transaction does not allow the next billing 
date to change such that it is less than the current billing date. 

Oracle Daybreak also notes the change on Loan Details sub pages in the Extn and Due 
Dates block’s # of Due Day Changes and Due Day Chg Dt fields.

To change a due date
Transaction Parameters
DUE DATE CHANGE TXN DATE

DUE DATE 

Extensions
Extension transactions allow you to extend a loan. An extension fee may be assessed when 
an account receives an extension. In case of precomputed loans, this is generally done to 
recoup the interest lost.
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Oracle Daybreak adjusts the due date on the Dues block’s Oldest Due Dt on the Customer 
Service form’s Account Details to reflect the extension.

It also notes the change with an entry on the Additional Loan Details sub page’s Exten-
sions and Due Dates block’s # of Extensions and # of Extension Term fields.

To apply an extension
Transaction Parameters
EXTENSION TXN DATE

EXTENSION TERM 

To adjust an extension fee
Transaction Parameters
ADJUSTMENT TO EXTENSION FEE - ADD TXN DATE

AMOUNT 

ADJUSTMENT TO EXTENSION FEE - SUBTRACT TXN DATE
AMOUNT 

To waive an extension fee
Transaction Parameters
WAIVE EXTENSION FEE TXN DATE

AMOUNT 
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Payment amount
You can change the current payment amount of an account. If the transaction is backdated, 
due amounts for the affected periods are re-calculated. While delinquency data could 
potentially change, prior statements are not be changed. The next ACH (if applicable) 
does not reflect the changed payment amount if the account has already been billed at the 
time of posting the transaction. Payments will be re-applied causing changes to account 
balances and late fees may be assessed (if applicable).

Note: You must calculate the new payment amount. Oracle Daybreak does not perform 
any checks on the new payment amount.

After you post the transaction, the new payment amount appears Customer Service (2) 
master tab’s Account Details page in the Current Pmt field of the Activity block.

To change the payment amount
Transaction Parameters
CHANGE PAYMENT AMOUNT TXN DATE

PAYMENT AMOUNT 
PAYMENT AUTO COMPUTER
     INDICATOR
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Prepayment penalty
A prepayment penalty is typically applied automatically by Oracle Daybreak if the 
account is paid off prematurely.

The following transactions allow you to adjust or waive the prepayment penalty fee.
The adjustments will appears in corresponding column of the Customer Service form’s 
Balances page for the FEE PREPAYMENT PENALTY Balance Type-- Waive, Adjusted (-), 
or Adjusted (+) -- depending on which of the following the transactions you perform.

To adjust a prepayment penalty 
Transaction Parameters
ADJUSTMENT PREPAYMENT PENALTY - ADD TXN DATE

AMOUNT 

ADJUSTMENT PREPAYMENT PENALTY - SUBTRACT TXN DATE
AMOUNT

To waive a prepayment penalty 
Transaction Parameters
WAIVE PREPAYMENT PENALTY TXN DATE

AMOUNT 
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Escrow payment
The following monetary transactions allow you to specify the escrow payment to be billed 
to the customer each month. Rescheduling an escrow payment allows you to change the 
payment rate (and hence the rate and term) and define when the change will begin. The 
“txn date” parameter is when the new agreement starts. 

The following transactions allow you to adjust or waive the escrow advance.
The adjustments will appears in corresponding column of the Customer Service form’s 
Balances page for the ESCROW ADVANCE Balance Type-- Waive, Adjusted (-), or 
Adjusted (+) -- depending on which of the following the transactions you perform.

To adjust escrow advance
Transaction Parameters
ADJUSTMENT TO ESCROW ADVANCE - ADD TXN DATE

AMOUNT 

ADJUSTMENT TO ESCROW ADVANCE - SUBTRACT TXN DATE
AMOUNT 

To waive escrow advance
Transaction Parameters
WAIVE ESCROW ADVANCE TXN DATE

AMOUNT 

To reschedule an escrow payment
Transaction Parameters
RESCHEDULE ESCROW PAYMENT TXN DATE

AMOUNT 

The new escrow payment amount appears on the Escrow page in the Escrow Payment 
block’s Current Escrow Pmt field.

Escrow balance refund 
If an account is paid off resulting in a positive (greater than $0) escrow balance or the last 
item being escrowed is removed resulting in a positive (greater than $0) escrow balance, 
then Oracle Daybreak refunds the escrow and creates a check requisition.
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Pay off quote fee
The PAYOFF QUOTE transaction on the Maintenance (3) master tab includes the required 
parameter ASSESS PAYOFF QUOTE FEE (Y/N). If you select Y, Oracle Daybreak assesses 
a payoff quote fee on the Customer Service form’s Balances page for the Balance Type 
FEE PAYOFF QUOTE. The amount of the payoff quote fee is based on contract setup.

The following transactions allow you to adjust or waive the pay off quote fee.
The adjustments will appears in corresponding column of the Customer Service form’s 
Balances page for the FEE PAYOFF QUOTE Balance Type-- Waive, Adjusted (-), or 
Adjusted (+) -- depending on which of the following the transactions you perform.

To adjust a pay off quote fee
Transaction Parameters
ADJUSTMENT TO PAYOFF QUOTE FEE - ADD TXN DATE

AMOUNT 

ADJUSTMENT TO PAYOFF QUOTE FEE - SUBTRACT TXN DATE
AMOUNT 

To waive a pay off quote fee
Transaction Parameters
WAIVE PAYOFF QUOTE FEE TXN DATE

AMOUNT 
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Nonperforming accounts
Loan accounts can be placed in a nonperforming, or nonaccrual, condition. Once an 
account is set to a nonperforming condition, Oracle Daybreak makes the following modi-
fications and accounting entries:

• After the transaction date, Oracle Daybreak assesses no late charge to this account.
• Stops general ledger entries for interest accrual.
• Transfers the existing principal balance on this account to the Non-Performing Bal-

ance Group on the Customer Service form’s Balance page.
• Charges the unearned dealer compensation back to the dealer.
• Treats payments posted to this account as it does with a normal account; however, the 

general ledger entries for allocation of these amounts towards principal and interest 
will go towards the nonperforming balance.

Oracle Daybreak’s general ledger (GL) is set up (Setup > General Ledger) for the above 
items. There will be no impact on the balances of the account (principal, interest, fee and 
expense) as a result of the above transactions.

To place an account in a nonperforming condition
Transaction Parameters
ACCOUNT NON PERFORMING TXN DATE

NON PERFORMING DESCRIP-
TION 

The following transaction removes the nonperforming condition on an account and 
reverses the nonperforming transactions explained above. General ledger entries for inter-
est accrual, stopped during nonaccrual stage, resume.

To reverse a nonperforming condition
Transaction Parameters
RESUME ACCOUNT PERFORMING TXN DATE
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Convert a precomputed (PC) loan into a simple interest (SI) loan
When converting a precomputed loan into a simple interest loan, Oracle Daybreak 
assumes the following default values: 

• Accrual Calculation Method - interest bearing (simple interest)
• Maturity Date - Computed from the term and next payment due date
• Monthly Payment Amount - Computed from the interest rate, new principal balance, 

accrual start date, and term.
• All balances other than the Note balance are carried over to the simple interest loan.

The resulting “new” simple interest loan will have the same account number with the 
details entered/computed above.

Caution: The converting a precomputed loan into a simple interest loan transaction can be 
performed only by closing the nonperforming condition. 

To reschedule precompute loan to interest bearing loan
Transaction Parameters
RESCHEDULE PRE-COMPUTE LOAN TXN DATE
TO INTEREST BEARING LOAN RESCHEDULE PAYMENT

       START DATE
AMOUNT
RATE
TERM
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Loan nonmonetary transactions
This section catalogues the transaction codes and parameters required to complete the fol-
lowing nonmonetary tasks for loans:

• Update a customer’s name
• Maintain customer details
• Mark a customer as a skipped debtor
• Change a customer’s Privacy Opt-Out indicator
• Stop correspondence
• Modify financed insurance information
• Start or stop an ACH
• Reprint a statement (batch only)
• Create or cancel a one time ACH - phone pay
•  reorder coupon books (or payment books)
• Cancel or adjust an ESC 
• Apply a refund payment to an ESC 
• Cancel insurance (or reverse the insurance cancellation)
• Add new escrow insurance details
• Add new escrow tax details
• Change insurance annual disbursement
• Change insurance disbursement plan
• Change escrow indicators of insurance
• Change insurance expiration date
• Change insurance maturity date
• Change tax annual disbursement
• Change tax disbursement plan
• Change escrow indicators of tax
• Resume escrow analysis
• Resume escrow disbursements
• Stop escrow analysis
• Stop escrow disbursements
• Refund or adjust insurance
•  Reorder coupon books (or payment books)
Appendix C :-25    User Guide - Consumer Loans Collection 



Customer name maintenance
You can update and change a customer’s name.

To update a customer’s name
Transaction Parameters
CUSTOMER NAME MAINTENANCE TXN DATE

RELATION TYPE CODE 
CUSTOMER FIRST NAME 
CUSTOMER MIDDLE NAME
CUSTOMER LAST NAME
CUSTOMER GENERATION
     CODE

The new name appears in the account title and on the Customer Service (2) master tab’s 
Account Details and Customer Details pages.
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Customer details maintenance
You can update and change the following details regarding a customer: social security 
number, marital status, disability indicator, driving license number, number of dependents, 
and email address.

To change other details about a customer 
Transaction Parameters
CUSTOMER MAINTENANCE TXN DATE

RELATION TYPE CODE
CUSTOMER SSN 
CUSTOMER MARITIAL
     STATUS CODE
CUSTOMER DISABILITY
     INDICATOR 
CUSTOMER DRIVING
     LICENSE NUMBER 
CUSTOMER NUMBER OF
     DEPENDENTS 
CUSTOMER EMAIL
     ADDRESS 1
CUSTOMER BIRTH DATE
CUSTOMER GENDER CODE
CUSTOMER LANGUAGE    
      CODE
CUSTOMER DRIVING 
     LICENSE STATE CODE
CUSTOMER TIME ZONE

The new details appears on the Customer Service (2) master tab’s Account Details and 
Customer Details pages.
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“Skipped” customers
When a customer cannot be located, Oracle Daybreak allows you to mark that person as 
“skipped” (as in, “the person is a skipped debtor.”) Marking a customer as skipped indi-
cates that the customer’s whereabouts are unknown.

To mark a customer as “skipped”
Transaction Parameters
CUSTOMER SKIP TXN DATE

RELATION TYPE CODE
CUSTOMER SKIP INDICATOR

The Skip box is selected on the Customer Service (2) master tab’s Account Details and 
Customer Details pages.

Note: To remove the Skip indicator, follow the procedures above; however, type N in the 
CUSTOMER SKIP INDICATOR parameter.

Privacy Opt-Out indicator
You can change the customer’s Privacy Opt-Out indicator.

To change the customer’s privacy opt-out indicator
Transaction Parameters
CUSTOMER PRIVACY INFO SHARING PREFERENCE PRIVACY OPTOUT

EFFECTIVE DATE
RELATION TYPE CODE 

The Primary Opt-Out box is selected on the Customer Service (2) master tab’s Account 
Details and Customer Details pages.

Note: To remove the Primary Opt-Out indicator, follow the procedures above; however, 
type N in the CUSTOMER STOP CORRESPONDENCE INDICATOR parameter.
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Correspondence (stopping)
You can choose at any time to stop correspondence to a customer. When you do so, the 
customer will receive no correspondence of any kind from Oracle Daybreak.

To stop correspondence with a customer
Transaction Parameters
CUSTOMER STOP CORRESPONDENCE TXN DATE

RELATION TYPE CODE
CUSTOMER STOP CORR
     INDICATOR

The Stop Correspondence box is selected on the Customer Service (2) master tab’s 
Account Details and Customer Details pages.

Note: To remove the Stop Correspondence indicator, follow the procedures above; how-
ever, type N in the CUSTOMER STOP CORRESPONDENCE INDICATOR parameter.

Financed insurance (modifying)
You can change other insurance details entered on the INSURANCE ADDITION transaction 
with the nonmonetary INSURANCE DETAILS MODIFICATION transaction. The changed 
insurance information can be viewed on Customer Service form’s Insurances page on the 
Customer Service (2) master tab.

Note: Please contact your account manager for back porting this functionality on existing 
loan accounts.

Transaction Parameters
INSURANCE MODIFICATION TXN DATE

EFFECTIVE DATE 
INSURANCE TYPE   
POLICY EFFECTIVE DATE   
COMPANY NAME 
PHONE # 1 
EXTN # 1 
PHONE # 2 
EXTN # 2 
POLICY # 
EXPIRATION DATE 
PRIMARY BENEFICIARY 
SECONDARY BENEFICIARY 
REFUND AMOUNT 
RECEIVED 
FULL REFUND RECEIVED 

COMMENT 
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ACH
With the Transaction page, you can either start or stop an automated clearinghouse, or 
electronic funds transfer, for an account.

To start an ACH for an account
Transaction Parameters
ACH MAINTENANCE TXN DATE

ACH BANK NAME
ACH BANK ROUTING 
     NUMBER 
ACH ACCOUNT TYPE CODE
ACH ACCOUNT NUMBER 
ACH PAYMENT DAY 
ACH PAYMENT AMOUNT 
ACH PAYMENT FEQUENCY
     CODE
ACH START DATE 

This information appears on the ACH sub page, available on the Balances, Transactions, 
Tracking Attributes, and Insurances pages on the Customer Service (2) master tab.

To stop an ACH for an account 
Transaction Parameters
STOP ACH MAINTENANCE TXN DATE

Oracle Daybreak clears the information on the ACH sub page, available on the Balances, 
Transactions, Tracking Attributes, and Insurances pages on the Customer Service (2) mas-
ter tab.
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Statement reprinting (batch only)
You can reprint a statement of account activity by defining the starting and closing dates 
included within the statement.

To reprint a statement 
Transaction Parameters
STATEMENT REPRINT MAINTENANCE TXN DATE 

STATEMENT CLOSING DATE

One time ACH - phone pay
Oracle Daybreak provides the ability to handle one time automated clearinghouse initiated 
by nonmaintenance transactions, giving you the ability to offer phone pay services to your 
customers. When accessing a phone pay, Oracle Daybreak creates an ACH file and gener-
ates payment batches.

Note: A one time ACH - phone pay transaction has parameters which are required for the 
ACH file processing.

To create one time ACH - phone pay
Transaction Parameters
ONETIME ACH - PHONE PAY BANK NAME

BANK CITY
ROUTING NUMBER
ACCOUNT TYPE
NAME AS IT APPEARS ON
     ACCOUNT
ACCOUNT NUMBER
DEBIT DATE
PAYMENT AMOUNT
PHONE PAY FEE
SECRET QUESTION
SECRET ANSWER
WHO AUTHORIZED
CHECK NUMBER

To cancel one time ACH - phone pay
Transaction Parameters
CANCEL ONETIME ACH - PHONE PAY (NO PARAMETERS)

* Post transaction to complete.
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Coupon book maintenance (batch only)
In reordering coupon books, you will need supply the first date of new coupons, the new 
coupon start number, and the number of new coupons to order.

To re-order coupon book (batch only)
Transaction Parameters
COUPON BOOK MAINTENANCE TXN DATE 

COUPON FIRST PAYMENT
     DATE 
COUPON START NUMBER 
COUPON COUNT 

• To cancel the coupon book re-order before it is processed in the nightly batch, choose 
Void.

Extended Service Contract (ESC)
You can apply, cancel, or adjust a payment to an extended service contract.

To cancel or adjust an ESC 
Transaction Parameters
WARRANTY MAINTENANCE TXN DATE

INSURANCE/WARRANTY
     CANCEL INDICATOR 
INSURANCE/WARRANTY
     CANCEL DATE 
INSURANCE/WARRANTY
     REMAINING TERM 
INSURANCE/WARRANTY
     REFUND AMOUNT 
     ESTIMATE 
INSURANCE/WARRANTY
     REFUND AMOUNT
     RECEIVED 
INSURANCE/WARRANTY
      FULL REFUND RECEIVED
      INDICATOR 
INSURANCE/WARRANTY 
ITEMIZATION CODE 
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To apply a refund payment to an ESC 
Transaction Parameters
WARRANTY PAYMENT MAINTENANCE TXN DATE

INSURANCE/WARRANTY
     REFUND AMOUNT
     RECEIVED
INSURANCE/WARRANTY
     ITEMIZATION CODE
INSURANCE/WARRANTY
     FULL REFUND RECEIVED
     INDICATOR 

Note: A Warranty Refund transaction posted or reversed on the Maintenance page should 
be matched with a payment posting or reversal.

Insurance maintenance

To cancel insurance (or reverse the insurance cancellation)
Transaction Parameters
INSURANCE MAINTENANCE TXN DATE

INSURANCE/WARRANTY
     CANCEL INDICATOR 
INSURANCE/WARRANTY
     CANCEL DATE 
INSURANCE/WARRANTY
     REMAINING TERM 
INSURANCE/WARRANTY
     REFUND AMOUNT 
     ESTIMATE 
INSURANCE/WARRANTY
     REFUND AMOUNT
     RECEIVED 
INSURANCE/WARRANTY
     FULL REFUND RECEIVED
     INDICATOR
INSURANCE/WARRANTY
     ITEMIZATION CODE 

Note: This is not asset or collateral insurance, but the account insurance; for example, 
“Credit Life and Disability.”
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Escrow information and maintenance
The following nonmonetary transactions allow you to add a new tax or insurance escrow 
to an account. 

To add new escrow insurance details
Transaction Parameters
NEW ESCROW INSURANCE DETAILS ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
ESCROW REQUIRED (Y/N)
ESCROW OPT OUT (Y/N)
ANNUAL DISBURSEMENT
     AMOUNT
DISBURSEMENT RULE
TRANSACTION DATE
REFERENCE ACCOUNT #
INSURANCE POLICY #
EXPIRATION DATE
MATURITY DATE
COVERAGE TYPE
COVERAGE TERM
COVERAGE AMOUNT
REASON
REFERENCE

To add new escrow tax details
Transaction Parameters
NEW ESCROW TAX DETAILS ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
ESCROW REQUIRED (Y/N)
ESCROW OPT OUT (Y/N)
ANNUAL DISBURSEMENT
     AMOUNT
DISBURSEMENT RULE
TRANSACTION DATE
REFERENCE ACCOUNT #
PROPERTY TAX TYPE
REASON
REFERENCE

The following nonmonetary transactions allow you to update any of the escrow informa-
tion regarding an existing tax and insurance.

To change insurance annual disbursement
Transaction Parameters
CHANGE INSURANCE ANNUAL DISBURSEMENT ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
ANNUAL DISBURSEMENT
     AMOUNT
REASON
Appendix C :-34    User Guide - Consumer Loans Collection 



REFERENCE

To change insurance disbursement plan
Transaction Parameters
CHANGE INSURANCE DISBURSEMENT PLAN ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
DISBURSEMENT RULE
REASON
REFERENCE

To change escrow indicators of insurance
Transaction Parameters
CHANGE ESCROW INDICATORS OF INSURANCE ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
ESCROW REQUIRED (Y/N)
ESCROW OPT OUT (Y/N)
REASON
REFERENCE

To change insurance expiration date
Transaction Parameters
CHANGE INSURANCE EXPIRATION DATE ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
EXPIRATION DATE
REASON
REFERENCE

To change insurance maturity date
Transaction Parameters
CHANGE INSURANCE MATURITY DATE ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
MATURITY DATE
REASON
REFERENCE

To change tax annual disbursement
Transaction Parameters
CHANGE TAX ANNUAL DISBURSEMENT ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
ANNUAL DISBURSEMENT
     AMOUNT
REASON
REFERENCE
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To change tax disbursement plan
Transaction Parameters
CHANGE TAX DISBURSEMENT PLAN ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
DISBURSEMENT RULE
REASON
REFERENCE

To change escrow indicators of tax
Transaction Parameters
CHANGE ESCROW INDICATORS OF TAX ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
ESCROW REQUIRED (Y/N)
ESCROW OPT OUT (Y/N)
REASON
REFERENCE

Escrow analysis disbursements
The following nonmonetary transactions allow you to resume and stop escrow analysis 
and disbursements. 

To resume escrow analysis
Transaction Parameters
RESUME ESCROW ANALYSIS TRANSACTION DATE

REASON
REFERENCE

To resume escrow disbursements
Transaction Parameters
RESUME ESCROW DISBURSEMENTS TRANSACTION DATE

REASON
REFERENCE

To stop escrow analysis
Transaction Parameters
STOP ESCROW ANALYSIS TRANSACTION DATE

REASON
REFERENCE

To stop escrow disbursements
Transaction Parameters
STOP ESCROW DISBURSEMENTS TRANSACTION DATE

REASON
REFERENCE
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Insurance payment maintenance

To refund or adjust insurance
Transaction Parameters
INSURANCE PAYMENT MAINTENANCE TXN DATE

INSURANCE/WARRANTY
     REFUND AMOUNT
     RECIEVED
INSURANCE/WARRANTY
     ITEMIZATION CODE 
INSURANCE/WARRANTY
     FOR FULL REFUND
     RECEIVED

Note: The insurance refund posted or reversed on the Maintenance page should be 
matched by a payment posting or reversal.
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APPENDIX D : PAYMENT AMOUNT CONVERSIONS

The following table contains the calculations Oracle Daybreak uses to convert the differ-
ent payment frequencies (weekly, biweekly, semimonthly, and so on) to standard monthly 
values for installment accounts.

Payment Frequency: Scheduled Monthly Income Amount:

D = Deferred Zero fill

P = Single payment loan Zero fill

W = Weekly (due every week) Multiple by 4.33

B = Biweekly (due every two weeks) Multiple by 2.16

E = Semimonthly (due twice a month) Multiple by 2

M = Monthly (due every month) As given

L = Bimonthly (due every two months) Divide by 2

Q = Quarterly (due every three months) Divide by 3

T = Triannually (due every four months) Divide by 4

S = Semiannually (due twice a year) Divide by 6

Y = Annually (due every year) Divide by 12
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